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Chapter 1

 

Address Book

 

Use the Address Book to maintain names, addresses, phone 
numbers, e-mail addresses, URLs, and other information about 
contacts.

 

With the Address Book, you can:

 

■

 

Tap a phone number from the Address List to make a phone call directly.

 

■

 

Look up or enter names, addresses, phone numbers and other 
information.

 

■

 

Enter up to five phone numbers or e-mail addresses for each contact.

 

■

 

Define which phone numbers appear in the Address List screen for each 
Address Book entry. 

 

■

 

Attach a note to each Address Book entry where you can enter 
additional information about the entry.

 

■

 

Assign categories to your Address Book entries, so you can quickly sort 
and view your entries in logical groups.

 

■

 

Define the contacts to include in the Speed Dialer list.

 

To open the Address Book:

1

 

Open the keypad, then tap  to open the Applications Launcher.

 

2

 

Tap  to display the Address Book list.
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Getting Started with Address Book Entries

 

An Address Book entry is where you store name and address information 
about people or businesses. pdQ smartphone makes it easy to create, edit 
and delete Address Book entries.

 

Creating an Address Book Entry

 

You can create Address Book entries on pdQ smartphone, or

 

 

 

you can use the 
Palm™ Desktop software to create Address Book entries on your computer 
and download the entries to pdQ smartphone with the next HotSync

 

®

 

 
operation. See the “HotSync” chapter for details.

The Palm Desktop software also has data Import capabilities that 
allow you to load database files into pdQ smartphone’s Address 
Book. Refer to the online documentation supplied with the Palm 
Desktop software for details.

 

To create a new Address Book entry:

1

 

Open the keypad, then tap  to open the Applications Launcher.

 

2

 

Tap  to display the Address List screen.

 

3

 

Tap New to display the Address Edit screen.

 

4

 

Enter the last name of the person you want to add to your Address Book. 

pdQ smartphone automatically capitalizes the first letter of each 
field (except 

 

numeric

 

 and e-mail fields). You do not have to use the 
Graffiti

 

®

 

 capital stroke to capitalize the first letter of the name. 

 

5

 

Use the Next Field Graffiti stroke to move to the First Name field.

Tap New

Cursor 
at Last 
name
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You can also move to any field by tapping it directly.

 

6

 

Enter the person's first name in the First Name field.

 

7

 

Repeat steps 4 and 5 to enter the other information that you want to 
include in this Address Book entry.

 

8

 

Tap  to move to the next page.

 

9

 

Tap Done to return to the Address List screen when finished.

You can create an Address Book entry that always appears at the 
top of the list by beginning the Last name (or Company name) field 
with a blank space. 

 

Adding an Address Book Entry to the Speed Dialer

 

To add an Address Book entry to the Speed Dialer list:

1

 

Open the keypad, then tap  to open the Applications Launcher.

 

2

 

Tap  to display the Address List screen.

 

3

 

Tap the line that contains the contact information you want to add to 
the Speed Dialer list, then tap Edit.

 

4

 

Tap the plus sign (

 

+

 

) that appears to the right of the phone number you 
want to add to the Speed Dialer list, then tap Done.  

 

5

 

Tap  to open the Applications Launcher.

 

6

 

Tap  to confirm the new Speed Dialer list entry.

 

Next Field

 

  

Tap Done
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Making a Phone Call from the Address Book

 

After you create an Address Book entry, you make a phone call from it 
directly. 

 

To make a phone call from the Address Book:

1

 

Open the keypad, then tap  to turn on the phone.

 

2

 

Tap  to display the Address List screen. 

 

3

 

Tap the phone number you want to call, then tap Dial.

 

4

 

Tap End when finished.

 

Editing an Address Book Entry

 

After you create an Address Book entry, you can update it or enter additional 
information any time.

 

To edit an Address Book entry:

1

 

Tap the Address Book entry that you want to change to display the 
Address View screen for that entry.

 

2

 

Tap Edit (or anywhere on the screen) to display the Address Edit screen.

 

3

 

Tap any field (such as Address or City) and enter or change the 
information.

 

4

 

Tap Done to return to the Address List screen when finished.

 

Deleting an Address Book Entry

 

There are two ways to delete an entry: use the Menu Commands (described 
in the “Record Menu” section of this chapter) or use the Address Entry 
Details dialog.

 

To delete an entry with the Address Entry Details dialog:

1

 

Tap the Address Book entry that you want to delete to display the 
Address View screen for that entry.
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2

 

Tap Edit to display the Address Edit screen.

 

3

 

Tap Details to open the Event Details dialog.

 

4

 

Tap Delete to open the Delete Address alert.

 

5

 

Tap OK to confirm you want to delete the entry.

 

Removing an Address Book Entry from the Speed Dialer

 

To remove an Address Book entry from the Speed Dialer:

1

 

Open the keypad, then tap  to open the Applications Launcher.

 

2

 

Tap  to display the Address List screen.

 

3

 

Tap the line that contains the contact information you want to remove 
from the Speed Dialer list, then tap Edit. 

 

4

 

Tap the minus sign (

 

-

 

) that appears to the right of the phone number 
you want to remove from the Speed Dialer list, then tap Done. 

 

5

 

Tap  to open the Applications Launcher.

 

Working With Address Book Entries

 

pdQ smartphone enables you to quickly find your Address Book entries, 
group them by category, and display the entries by name or company name. 
You can also choose the type of information you want your entries to include 
and exchange Address Book information with other pdQ smartphone users.

 

Looking Up Address Book Entries

 

When working with the Address Book, the scroll button on the front panel 
of pdQ smartphone makes it easy to navigate among your address entries. 
In the Address List screen, the scroll button moves up or down an entire 
screen of address entries. If you hold down the scroll button, you accelerate 
the scrolling so that it displays every third screen. In the Address View 
screen, the scroll button moves to the previous or next address entry.

You can also use the Address List Look Up feature to quickly scroll to any of 
your Address Book entries. 

 

To look up an Address Book entry:

1

 

Tap  to display the Address List screen from the Applications 
Launcher.

 

2 Enter the first letter of the name you want to find.
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The letter appears on the Look Up line and the list scrolls to the 
first entry that begins with that letter. If you write another letter, 
the list scrolls to the first entry that starts with those two letters. 
For example, writing an “s” might scroll to “Sands,” and writing 
“sm” might scroll further to “Smith.” If you sort the list by company 
name, the Look Up feature scrolls to the first letter of the company 
name.

3 Tap any entry to view its contents, or use the carriage return stroke to 
view the selected entry.

Choosing Types of Phone Numbers
pdQ smartphone enables you to choose the types of phone numbers or e-
mail addresses that you associate with an Address Book entry. Any changes 
you make will apply only to the current Address Book entry. 

To choose other types of phone numbers in an Address Book entry:

1 Tap the Address Book entry that you want to change to display the 
Address View screen for that entry. 

2 Tap Edit to display the Address Edit screen for that entry.

3 Tap  for the label you want to change. 

Look Up line

▼
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4 Tap the new label you want to use.

Assigning Address Categories
Categories can help you file individual Address Book entries into groups for 
easy review. You can assign and edit categories in the Address Book or by 
using the Categories pick list in the Details dialog (see “Using Categories” 
in the pdQ Basics Handbook for a complete description of categories). 

To assign a category to an Address Book entry:

1 Tap the Address Book entry you want to assign to a category. 

2 Tap Edit in the Address View screen to display the Address Edit screen.

3 Tap  in the upper-right corner for the category you want to assign to 
the Address Book entry.

Sorting by Name or Company
You can sort the entries in the Address List screen by Company and Last 
Name, rather than by Last Name and First Name. These settings do not 
change your Address Book data in any way; they merely change the view.

To sort the entries in the Address List screen:

1 Tap  to open the Address List screen.

2 Tap  to open the Address Book menus.

3 Tap Preferences from the Options menu to open the Address Book 
Preferences dialog.

Tap 
triangle

▼
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4 Tap the setting that you want for the Address List screen.

5 Tap OK to display the Address List screen with your new setting.

Entries with no company name sort by last name. 

Changing Address Entry Details
The Address Entry Details dialog provides a variety of options that you can 
associate with an Address entry. 

To open the Address Entry Details dialog:

1 Tap an Address Book entry to display the Address View screen  for that 
entry.

2 Tap Edit to display the Address Edit screen.

3 Tap Details to open the Address Entry Details dialog.

4 Select any of the following settings:

Show in List Choose the information that appears for the current 
entry in the Address List screen. Choose from: Work, 
Home, Fax, Other and E-mail.

Category Assign the entry to one of these categories: Business, 
Personal, QuickList, Unfiled and Edit Categories.

Private Hide this entry when security features are turned on.
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Beaming Address Entries to Other pdQ Smartphones
The IR port on pdQ smartphone enables you to beam Address Book entries 
to other pdQ smartphones. You can beam any of the following:

■ Business card A specially designated entry containing information you 
want to exchange with business contacts. You can send your business 
card quickly with one-touch beaming.

■ Current address entry The entry currently selected on pdQ smartphone. 
For example, you may want to beam the name of a business contact to 
a coworker who also uses a pdQ smartphone.

■ Category of address entries All of the entries that you have assigned 
to the selected category. For example, you might want to share your list 
of restaurants with a friend. 

For more on the IR port, see “Beaming Information to Other pdQ 
Smartphones” in the pdQ Basics Handbook.

To select a business card:

1 Create an Address Book entry containing the information you want on 
your business card.

2 Tap your business card entry to display the Address View screen for that 
entry.

3 Tap  to open the Address Book menus.

4 Tap Select Business Card from the Record menu, and tap Yes to accept 
this entry as your business card.

To beam a business card:

1 Tap your business card entry to display the Address View screen for that 
entry.

2 Tap  to open the Address Book menus.

3 Tap Beam Business Card from the Record menu to beam your card to 
another pdQ smartphone.

You can also press  for about two seconds to beam your card. 
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To beam the current entry: 

1 Tap an Address Book entry that you want to beam to display the Address 
View screen for that entry.

2 Tap  to open the Address Book menus.

3 Tap Beam Address from the Record menu to beam the current entry to 
another pdQ smartphone through the IR port. 

You can set the full-screen pen stroke to beam the current entry. 
See “Pen Preferences” for details. 

To beam the current category: 

1 Display the Address List screen.

2 Tap the  in the upper-right corner for the category you want to beam 
to display the entries in that category.

3 Tap  to open the Address Book menus.

4 Tap Beam Category from the Record menu to beam the entries in the 
current category to another pdQ smartphone through the IR port.

Address Book Menu Commands
The Address Book includes menu commands to make it fast and easy to 
perform common file and editing tasks. This section explains the menu 
commands that are specific to the Address Book.

Refer to “Using Menus” in the pdQ Basics Handbook for information about 
menu commands common to pdQ smartphone applications.

Record Menu
When you select the Record menu, its commands appear on the screen. The 
menu commands are slightly different depending on the current screen.

▼

Address List 

Address View
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Delete Address Opens an alert dialog prompting you to confirm 
deletion of the current entry. Tap OK to delete the 
entry from pdQ smartphone, or tap Cancel to close the 
alert dialog and keep the entry.

By default, pdQ smartphone removes the entry from 
the Address Book, but retains a copy of the entry and 
transfers it to an archive file on your computer the 
next time you perform HotSync. To remove the entry 
completely, clear the Save archive copy on PC check 
box. 

Attach Note Opens the Address Book Note dialog where you can 
create a Note for the current entry.

Delete Note Opens an alert dialog prompting you to confirm 
deletion of the Note attached to the entry. Tap OK to 
delete the Note, or tap Cancel to close the alert dialog 
and keep the note. 

Beam Address Beams the current Address Book entry to another pdQ 
smartphone through the IR port.

Beam Category Beams all Address Book entries in the current 
category to another pdQ smartphone through the IR 
port.

Select Business 
Card

Enables you to select the current Address Book entry 
as your business card. To beam your business card to 
other pdQ smartphones, use the Beam Business Card 
command.

Beam Business 
Card

Sends the current business card to another pdQ 
smartphone through the IR port. You can also initiate 
this command by holding down the Address Book 
button for at least two seconds. This is a convenient 
way to exchange business cards with other pdQ 
smartphone users.
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Options Menu
When you select the Options menu, its commands appear on screen.

Font Opens the Select Font dialog where you can choose a 
different font (text) style for your Address Book 
entries. See “Choosing Fonts” in the pdQ Basics 
Handbook for details.

Preferences Opens the Address Book Preferences dialog.

Remember last category Determines how the Address 
Book appears when you return from another pdQ 
smartphone application (Memo Pad, To Do List, etc.). 
If you select this check box, the Address Book shows 
the last category you selected. When you clear it, the 
Address Book shows the address entries for all 
categories.

List By Determines whether address entries sort by 
last name, first name or by company name, last name 
in the Address List screen.

Address List 
Address View
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Rename Custom 
Fields

Enables you to define custom field names. Each 
Address Book entry contains four “custom fields” that 
you can rename. Any changes you make to the names 
of the custom fields appear in all of your Address Book 
entries. 

About Address 
Book

Shows version (revision) information for the Address 
Book application.
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Chapter 2

Calculator

The Calculator enables you to perform basic calculations. You can 
also store and retrieve values in the Calculator’s memory.

To open the Calculator:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Calculator.

Using the Calculator Screen
The Calculator is designed to perform addition, subtraction, multiplication 
and division operations. 

To use the Calculator screen:

Use your fingers or the stylus to tap the Calculator buttons that appear 
on the screen.

Special Calculator Buttons
The Calculator includes several buttons to help you perform calculations.

Clears the last number you entered. Use this button if you make 
a mistake while entering a number in the middle of a calculation. 
This button allows you to re-enter the number without starting 
over.

Clears the entire calculation and allows you to begin a fresh 
calculation.

▼
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Calculator Menu Commands
The Calculator supports the Copy and Paste commands. You can use these 
commands to copy a value from the Calculator and paste it into another 
application on pdQ smartphone. Similarly, you can copy values from other 
applications on pdQ smartphone, such as Expense, and paste the values into 
the Calculator. For additional information on the Copy and Paste commands, 
see “Using Menus” in the pdQ Basics Handbook.

Recent Calculations
The Recent Calculations command enables you to review the last series of 
calculations, and is particularly useful for confirming a series of “chain” 
calculations.

To display the recent calculations:

1 Tap  to open the Calculator menus.

2 Tap Recent Calculations from the Options menu to display the Recent 
Calculations screen.

Toggles the current number between a negative and positive 
value. If you want to enter a negative number, enter the number 
first and then press the +/- button.

Places the current number into Memory. Each new number you 
enter with the M+ button is added to the total already stored in 
memory. The number that you add can be either a calculated 
value, or any number you enter by pressing the number buttons. 
Pressing this button has no effect on the current calculation (or 
series of calculations); it merely places the value into memory 
until it is recalled.

Recalls the stored value from memory and inserts it in the current 
calculation.

Removes any value that is stored in the Calculator memory.
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3 After you finish reviewing the dialog, tap OK to close the Recent 
Calculations dialog and return to the Calculator.
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Chapter 3

Call History

Call History maintains a list of up to 99 incoming, outgoing, and 
missed calls. To ensure the list does not exceed 99 entries, pdQ 
smartphone automatically replaces older entries with new entries. You 
must have had incoming or outgoing calls in order for Call History to 

contain information.

Call History:

■ Organizes calls into three categories: Incoming, Outgoing and Missed.

■ Displays information about each call by individual category or by all 
categories at one time.

■ Sorts calls by column heading (Who, Date, Length) for each category.

To open Call History:

Open the keypad, then tap  to open the Call History list.

To make a call from the Call History list:

1 Open the keypad, then tap  on pdQ smartphone’s screen to turn on 
the phone.

2 Tap  to open the Call History list.

3 Tap the entry you want to call, then tap Dial.

▼
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To copy information about a call from Call History to the Address Book:

Tap the entry you want to add to the Address Book, then follow the 
instructions on the screen.

To delete one entry from the Call History list:

 Tap the entry you want to delete, then tap Delete.

To delete all entries from the Call History list:

1 Tap  from the Call History list.

2 Tap Delete All from the Record menu.

To sort Call History list entries by column heading:
No matter which sort sequence you choose, new calls automatically appear 
at the top of the list.

Tap Who to sort the list in numeric-alphabetic sequence. Tap Who again 
to resort the list in alphabetic-numeric sequence.

or

Tap Date to sort the list in the most recent date-most recent time 
sequence. Tap Date again to resort the list based on the most recent 
time.

or

Tap Length to sort the list in the longest call-shortest call sequence. 
Tap Length again to resort the list in the shortest call-longest call 
sequence.

To define Call History preferences:

1 Tap  from the Call History list.

2 Tap Preferences from the Options menu.

3 Tap the appropriate checkbox.

4 Tap OK when finished.

Don’t show 
name in 
summary

Select to ensure that caller names do not appear in 
the Who column even if the information is available. 

Delete calls 
after ___ days

Select to delete Call History list entries based on the 
number of days indicated. 

▼
▼

▼
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Chapter 4

Date Book

The Date Book enables you to quickly and easily schedule 
appointments or any kind of activity associated with a specific time 
and date.

With the Date Book, you can:

■ Enter a description of your appointment and assign it to a specific time 
and date.

■ Display a chart of your appointments for an entire week. The Week View 
feature makes it easy to spot any potential scheduling overlaps or 
conflicts.

■ Display a monthly calendar to quickly spot days where you have 
morning, lunch or afternoon appointments.

■ Set an alarm to sound prior to a scheduled activity. 

■ Create reminders for events that are based on a particular date, rather 
than time of day. Birthdays and anniversaries are easy to track with 
your pdQ smartphone.

■ Attach notes to individual events for a description or clarification of 
the entry in your Date Book.

To open the Date Book:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Date Book screen.
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Scheduling an Event
An event can be any kind of activity that you schedule for a particular day. 
When the Date Book screen first appears, it shows the current date ( ) and 
a list of times for a normal business day. You can enter a new event on any 
of the available time lines. 

When you create an event, its description appears on the time line, and its 
duration is automatically set to one hour. You can easily change the start 
time and duration for any event.

You can also include events in your Date Book that occur on a particular date 
but have no specific start or end times, such as birthdays, holidays and 
anniversaries. These are referred to as untimed events. Untimed events 
appear at the top of the Date Book screen and are noted by a diamond. You 
can have several untimed events on a particular date.

To schedule an event for the current day:

1 Tap the time line that corresponds to your event in the Date Book 
screen.

2 Enter information about the event. 

3 If your appointment is longer or shorter than an hour, tap the time of 
the event to open the Set Time dialog. If your appointment is one hour 
long, skip to step 7.

You can also open the Set Time dialog (to select a start time) by 
making sure no event is selected, then writing a number on the 
number side of the Graffiti writing area.

Tap a time 
line

Enter event 

Time bar 
shows 
duration
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4 Tap the time columns on the right side of the Set Time dialog to set the 
Start Time.

5 Tap the End Time box, then tap the time columns to set the End Time.

6 Tap OK to confirm your selection and close the Set Time dialog.

7 Tap a blank area of the screen to de-select the event. A vertical line 
appears next to the time, indicating the duration of the event.

Tap the 

Start Time 
highlighted

Tap to scroll to 
earlier hours

Tap to scroll to 
later hours

Tap to change 
hours

Tap to change 
minutes
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To schedule an event for another day:

Select the date you want for the event by doing one of the following: 

■ Tap the day of the week that you want in the Date Bar at the top of the 
Date Book screen. Tap the Previous week or Next week scroll bars to 
move to another week.

■ Tap Go To to open the Go to Date dialog. Select a date by tapping a 
year, month and day in the calendar.

■ Tap the scroll button to scroll to another day. Press the upper half of 
the button to move to the previous day or the lower half to move to the 
next day. 

■ After you locate the date, follow the steps described in the previous 
section, “To schedule an event for the current day.”

To schedule an untimed event: 

1 Select the date that you want for the event as described in the previous 
section, “To schedule an event for another day.”

2 Tap New to open the Set Time dialog.

Previous 
week

Next 
week

Tap to select the day of 
the current week

Previous year Next year

Tap to select
current date

Tap to scroll to 
earlier hours

Tap to scroll to 
earlier hours
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3 Tap OK, so that no start or end times are defined for the new event.

You can also create a new untimed event by making sure no event 
is selected, then writing letters in the Graffiti writing area.

4 Enter a description for the event (which appears at the top of the Date 
Book screen).

5 Tap a blank area on the screen to de-select the untimed event.

If you create an event and decide later that there is no particular 
start or end time, you can easily change it to an untimed event. 
Tap the time of the event in the Date Book screen, tap No Time, 
and then tap OK to confirm your selection and close the Set Time 
dialog.

No time 

New 
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Rescheduling an Event
You can easily make changes to your schedule with pdQ smartphone. 

To reschedule an event:

1 Tap the event you want to reschedule.

2 Tap Details to open the Event Details dialog for that event.

3 Tap the Time box and select the new time as described earlier in this 
chapter to change the time.

4 Tap the Date box and select the new date as described earlier in this 
chapter to change the date.

5 Tap OK to close the Event Details dialog and return to the Date Book 
screen.

Setting an Alarm for an Event
The Alarm setting enables you to set an audible alarm to remind you of  
events in your Date Book. You can set an alarm to sound minutes, hours or 
days before an event. The default Alarm setting is 5 minutes before the time 
of the event, but you can change this to any number of minutes, hours or 
days.

When you set an alarm,  appears to the far right of the event with the 
alarm. When the alarm tone sounds, a reminder message also appears on pdQ 
smartphone’s screen.

To set an alarm for an event:

1 Tap the event to which you want to assign an alarm.

2 Tap Details to open the Event Details dialog for that event.

3 To activate the alarm, select the Alarm check box in the Event Details 
dialog.

4 Tap  to select Minutes, Hours or Days.

5 Select the “5” and enter any number from 0 to 99 (inclusive) as the 
numeric alarm setting.

▼
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6 Tap OK to close the Event Details dialog and return to the Date Book 
screen.

You can set a silent alarm for an untimed event. In this case, the 
alarm triggers at the specified period of minutes, hours or days 
before midnight of the day of the untimed event. No audible alarm 
sounds for an untimed event; instead, the reminder message 
appears on pdQ smartphone’s screen.

For example, you could create a reminder for an untimed event 
that occurs on February 4th. If the alarm reminder is set for 5 
minutes, the alarm reminder appears at 11:55 PM on the night of 
February 3rd. The reminder remains on the screen until you turn 
on pdQ smartphone and tap OK to dismiss it.

Scheduling Repeating Events
The Repeat function enables you to schedule events that recur at regular 
intervals. A birthday is a good example of an event that repeats annually. 
Another example would be a weekly guitar lesson that falls on the same day 
of the week and at the same time of day. After you enter a repeating event, 

 appears to the far right of the event.

To schedule a repeating event:

1 Tap anywhere on the text of an event in the Date Book screen.

2 Tap Details to open the Event Details dialog.

Tap here to 
select alarm unit

Enter numeric
setting here
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3 Tap Repeat to open the Change Repeat dialog.

4 Tap Day, Week, Month or Year in the Change Repeat dialog.

5 In the “Every” area, enter a number that corresponds to how often you 
want the event to repeat. For example, if you select Month and enter 
the number “2,” the event repeats every other month.

6 If you want to specify an ending date for the repeating event, tap the 
End on pick list and tap Choose Date. Use the Date Picker to select an 
end date.

7 Tap OK to close the Change Repeat dialog and activate your settings.

Considerations for the Repeat Function
■ If you change the start date of a repeating event, the pdQ smartphone 

calculates the number of days you have moved the event. pdQ 
smartphone then automatically changes the end date to maintain the 
duration of the repeating event.

■ If you change the repeat type (such as, daily to weekly) of a repeating 
event, past occurrences (prior to the day on which you change the 
setting) are left alone and pdQ smartphone creates a new repeating 
event.

■ If you change the date of an occurrence of a repeating event (such as, 
from January 14th to January 15th) and apply the change to all 
occurrences, the new date becomes the start date of the repeating 
event. pdQ smartphone adjusts the end date to maintain the duration 
of the event.

■ If you change other repeat settings (such as, time, alarm, private) of a 
repeating event and apply the change to all occurrences, pdQ 
smartphone creates a new event. The start date of this new event is the 
day on which the setting is changed. Past occurrences (prior to the day 
of the change) are left alone and not changed.

■ If you make a change to one occurrence of a repeating event (such as 
time), that occurrence no longer shows the Repeat icon.

Tap the 
Repeat 
box
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Marking a Private Event
You can designate a specific event as “private.” When you activate the 
Security features, pdQ smartphone hides all private entries and you must 
enter a password to display them on the screen. 

To mark an event as private:

1 Tap the event you want to mark as private.

2 Tap Details to open the Event Details dialog for that event.

3 Select the Private check box.

4 Tap OK to close the Event Details dialog and return to the Date Book 
screen.

Deleting an Event
There are three ways to delete an event from the Date Book application: 
simply delete the text of the event, use the Menu Commands (described in 
the “Record Menu” section later in this chapter), or use the Event Details 
dialog. 

If you delete the text of a repeating event, you delete all instances 
of that event. If you use the Menu Command or the Event Details 
dialog, you can delete one occurrence of the event (as an 
exception) or all occurrences.

To delete an event with the Event Details dialog:

1 Tap anywhere in the text area of the event to delete.

2 Tap Details to open the Event Details dialog. 

3 Tap Delete to open the Delete Event alert.

4 Tap OK to confirm you want to delete the event.

Changing the Date Book View
In addition to displaying the calendar for a specific day, you can also display 
your Date Book by the week or month, and you can display the current time. 

To toggle through the different views:

Press the Date Book button repeatedly to display the next view.▼
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To display the current time:

Tap the date in the Date Book title bar to display the current time.

After a few seconds, the title bar reverts to show the date.

Working in Week View
The Week View shows a chart of your events for an entire week. This view 
lets you quickly review your appointments and available time slots.

In addition, the graphical display helps you spot overlaps and conflicts in 
your schedule.

To display the Week View:

1 Tap Week View in the Date Book screen to display the Week View.

2 Tap the navigation controls to move forward or backward a week at a 
time, or to display details of an event. 

The Week View also shows untimed events and events that are 
before and after the range of times shown.

▼

Tap the date Current time displays

Week view
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3 Tap any of your events to show a description of the event.

If you want to reschedule an event, tap and drag the event to a different 
time or day.
You can tap a blank time on any day to move to that day and have the 
time selected for a new event. Or you can tap any of the days and dates 
that appear at the top of the Week View to move directly to that day 
without selecting an event.
The Week View shows the time span defined by the Start Time and End 
Time in the Date Book Preferences settings. If you have an event before 
or after this time span, a bar appears at the top or bottom of that day's 
column, and these  on-screen scroll arrows appear if your scheduled 
events go beyond the displayed time range.

Spotting Event Conflicts in Week View
With the ability to define specific start and end times for any event, it’s 
possible to schedule events that overlap (an event that starts before a 
previous event finishes).

Previous 
week

Next 
week

Tap for that day

Bar indicates event above display

Bar indicates event below display

Dot indicates untimed event

Event details

Tap to show Event details
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In this case, any event conflict (time overlap) appears in the Week View as 
overlapping bars. The Day View displays bracketed bars to the left of the 
conflicting times.

Working in Month View
The Month View screen shows which days have events scheduled. Dots and 
lines in the Month View indicate events, repeating events and untimed 
events.

Tap any day that appears in the Month View screen to move directly to that 
day with the Day View screen. Tap the arrows at the top to move forward or 
backward a month. Tap Go To to open the Date Picker and choose a different 
month.

When the Month View is on the screen, tap the scroll button to move 
between months. Press the upper half of the button to display the previous 
month, or press the lower half to display the next month.

You can control the dots and lines that appear in the Month View. 
See “Options Menu” later in this chapter.

Event 
conflicts

Previous/next month

Dots on right side indicate events

Dashed line indicates daily repeating 

Dot below date indicates untimed events

Month view button
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Date Book Menu Commands
The Date Book includes menu commands to perform common file and editing 
tasks. This section explains the menu commands that are specific to the 
Date Book. 

See “Using Menus” in the pdQ Basics Handbook for information about menu 
commands common to all of pdQ smartphone applications.

Record Menu
When you select the Record menu, its commands appear on screen.

New Event Creates an event and opens the Set Time dialog 
where you can choose start and end times for the 
new event. If you do not enter start and end times, 
it creates a blank untimed event.

Delete Event Opens an alert dialog, prompting you to confirm 
that you want to delete the current event. You 
must tap an event before you use the Delete Event 
command. Tap OK to delete the event from pdQ 
smartphone, or tap Cancel to close the alert dialog 
and keep the event.

By default pdQ smartphone removes the event 
from the Date Book, but retains a copy of the 
event and transfers it to an archive file on your 
computer the next time you perform a HotSync® 
operation. To remove the event completely, clear 
the Save archive copy on PC check box. 

Attach Note Opens the Note dialog, where you can create a 
Note for the current event.
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Delete Note Opens an alert dialog, prompting you to confirm 
that you really want to delete the Note attached to 
the event. Tap OK to delete the Note from the 
memory of pdQ smartphone, or tap Cancel button 
to close the alert dialog and return to the Date 
Book.

Purge Opens an alert dialog, prompting you to confirm 
that you want to purge events older than a certain 
time period — based on pdQ smartphone’s internal 
clock. You can use the Purge command to conserve 
memory on pdQ smartphone. The default setting 
for the Purge alert is to “Save archive copy on PC.” 
This setting removes events from the Date Book, 
but retains copies and transfers them to an archive 
file on your computer during the next HotSync 
operation.

The Purge command also deletes repeating events 
if they end before the date that you activate the 
Purge command.

Beam Event Beams the current event to another pdQ 
smartphone through the IR port. See “Beaming 
Information to Other pdQ smartphones” in the pdQ 
Basics Handbook for more information.
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Options Menu
When you select the Options menu, its commands appear on screen.

Font Opens the Select Font dialog where you can choose a 
different font (text) style for your Date Book entries. 
See “Choosing Fonts” in the pdQ Basics Handbook for 
details.

Preferences Enables you to set the range of times that appear in 
the Date Book, and to automatically activate alarms 
for each event. 

Start/End Time Enables you to define the start and 
end times for the Date Book screens. If the time slots 
you select do not fit on one screen, you can tap the  
arrows to scroll up and down.

Alarm Preset Automatically sets an alarm for each 
new event. The alarm for untimed events is defined by 
minutes, days or hours before midnight of the date 
associated with the event. 

Alarm Sound Controls the type of tone the alarm 
generates when it sounds.
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Remind Me Defines how many times the alarm 
sounds. The choices are: Once, Twice, 3 times, 5 times 
and 10 times.

Play Every Defines how often the alarm sounds. The 
choices are every: Minute, 5 minutes, 10 minutes and 
30 minutes.

Display Options Allows you to change the Date Book’s appearance and 
which events display.

Show Time Bars Activates the time bars that appear 
in the Day View. The time bars show the duration of 
an event and illustrate event conflicts.

Compress Day View Controls how times appear in the 
Day View. When Compress Day View is off, all time 
slots display. When it is on, start and end times 
display for each event, but blank time slots toward 
the bottom of the screen disappear to minimize 
scrolling. 

Month View Settings These check boxes apply to the 
Month View of the Date Book. You can activate any or 
all of these settings to show that you have Timed, 
Untimed or Daily Repeating events in the Month View 
only.

Phone Lookup Activates the Phone Lookup feature. See “Using 
Phone Lookup” in the pdQ Basics Handbook.

About Date Book Shows version (revision) information for the Date 
Book application.
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Chapter 5

Dialer

The Dialer gives you access to an on-screen keypad while the 
keypad on the front of pdQ™ smartphone is open. The Dialer’s 
keypad works the same as the keypad on the front of the pdQ 
smartphone.

 With the Dialer, you can:

■ Make phone calls as if you were using the keypad on the front of pdQ 
smartphone.

■ Make phone calls using the Address Book.

■ Make phone calls using the Speed Dialer.

To open the Dialer:

Open the keypad, then tap  to display the on-screen keypad.

To make a call using the Dialer: 

Use the Dialer to make phone calls with the keypad open.

1 Open the keypad, then tap  on the pdQ smartphone screen to turn on 
the phone.

2 Tap  to display the on-screen keypad.

3 Tap keys to enter a phone number, then tap Send.

4 Tap End when finished.

▼
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To make a call from the Dialer using the Address Book:

You use the Volume Control buttons, located on the left, side panel of the 
pdQ smartphone, to scroll through the Address Book. Address Book list 
entries display above the keys on the Dialer keyboard.

1 Open the keypad, then tap  on the pdQ smartphone screen to turn on 
the phone.

2 Tap  to display the on-screen keypad.

3 Press the Volume Control buttons to scroll through the Speed Dialer list.

4 When the phone number you want to call appears above the Dialer 
keypad, tap Send.

5 Tap End when finished.

To make a call from the Speed Dialer:
If you can’t remember the number in the Speed Dialer list that corresponds 
to a phone number, tap a number on the keypad. When the pdQ smartphone 
detects a pause, it displays entries from the Speed Dialer list at the top of 
its screen. Press the Volume Control buttons on the left, side panel of the 
pdQ smartphone to scroll through the Speed Dialer list.

1 Open the keypad, then tap  on the pdQ smartphone screen to turn on 
the phone.

2 Tap  to display the on-screen keypad.

3 Tap the number from the Speed Dialer list that corresponds to the phone 
number you want to call, then tap Send.

4 Tap End when finished.
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Chapter 6

Expense

The Expense application enables you to keep track of your expenses 
and then transfer the information to a spreadsheet on your 
computer.

With the Expense application you can:

■ Record dates, types of expenses, amount spent, payment method and 
other details associated with any money that you spend.

■ Create categories for your expenses, such as business and personal 
expenses associated with a range of dates.

■ Keep track of vendors (companies) and people involved with each 
particular expense.

■ Log miles traveled for a particular date or expense category.

■ Sort your expenses by date or expense type.

■ Transfer your expense information to a Microsoft® Excel spreadsheet 
(version 5.0 or later) on your computer. (Microsoft Excel is not included 
with the pdQ™ smartphone package.)

To open Expense:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Expense List screen.
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Creating an Expense Item
Expense enables you to record the date, expense type and the amount that 
you spent. You can sort your expense items into categories or add other 
information that you want to associate with the item.To create an expense 
item:

1 Tap New in the Expense List to create a new item.

You can also create a new expense item by writing on the number 
side of the Graffiti® pad while in the Expense List screen. The first 
number you write begins your new expense item.

2 Enter the amount of the expense. 

3 Tap the Expense Type pick list and select a type from the list.

As soon as you select an expense type, pdQ smartphone saves your 
entry. If you do not select an expense type, it does not save the 
entry.

A quick way to create a new expense item is to make sure that no 
expense item is selected in the Expense List, write the first 

Tap New

Cursor 
of new 
item

Tap here
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letter(s) of the expense type, and then write the numerical 
amount of the expense item. This technique takes advantage of 
the automatic fill feature. See “Options Menu” later in this chapter 
for details.

Changing the Expense Item Date
Initially, expense items appear with the date you enter them on pdQ 
smartphone. You can use the Expense application to change the date 
associated with any expense item.

To change the date of an expense item:

1 Tap the expense item you want to change to highlight the date.

2 Tap the date of the selected item to open the Date dialog. 

3 Tap the date you want for the expense item.

For more information about the Date dialog, see “Scheduling an Event.”

Entering Receipt Details
The Expense application provides a variety of options that you can associate 
with an item. These options appear in the Receipt Details dialog.

To open the Receipt Details dialog:

1 Tap the expense item you want to assign details.

2 Tap Details to open the Receipt Details dialog.

Tap date
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3 Select any of the following options:

Category Defines the category for the Expense item. The 
default category is Unfiled when All is selected. 
Otherwise, the default is the currently selected 
category. An expense item remains in the default 
category until you change it.

pdQ smartphone provides two sample categories, 
New York and Paris, to show how you might sort 
your expenses according to different business 
trips.

Choose Edit Categories from the pick list to change 
existing or to create new expense categories. For 
example, you might create a category for a range 
of dates, such as a week or month, or you might 
delete or rename the New York and Paris 
categories. 

Type Opens a pick list of the expense type options so 
that you can change the expense type for any of 
your expense items. 

Payment Enables you to choose the payment method used 
to pay the expense item. If the item is prepaid 
(such as airline tickets supplied by your company), 
you can choose Prepaid to place your expense in 
the appropriate company-paid cell of your printed 
expense report spreadsheet. See “Transferring Your 
Data to Microsoft Excel” later in this chapter for 
more information.
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Tap Lookup to display the names (and the corresponding 
companies) of the people in your Address Book. 

4 Tap OK to close the Receipt Details dialog and activate your selections.

Currency Enables you to choose the type of currency used to 
pay the expense item. The default currency unit is 
defined in the Preferences dialog (see “Preferences 
Menu” later in this chapter). You can also display 
up to four other common types of currency. See 
“Customizing the Currency Pick List” later in this 
chapter for details.

Vendor and City Enable you to record the name of the vendor 
(usually a company) associated with the expense 
and the city where the expense was incurred. For 
example, a business lunch might be at Rosie's Cafe 
(Vendor) in San Francisco (City).

Attendees Displays the Attendees screen, which resembles a 
memo in the Memo Pad. You can use this screen to 
list the people who attended the activity 
associated with the expense or to make notes, 
such as the purpose of the expense.

Tap here
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Customizing the Currency Pick List
You can select the currencies and symbols that appear in the Currency pick 
list.

To customize the Currency pick list:

1 Tap the Currency pick list in the Receipt Details dialog, then tap the Edit 
Currencies selection to open the Select Currencies dialog.

2 Tap each Currency pick list to choose the country whose currency you 
want to display on that line.

3 Tap OK to close the Select Currencies dialog and activate your 
selections.

If the currency you want to use is not in the list of countries, you 
can create your own custom country and currency symbol. See 
“Expense Menu Commands” later in this chapter for details.

Show Options
The Show Options define the sort order and other settings that relate to your 
expense items.

To open the Show Options dialog:

1 Tap Show in the Expense List to open the Show Options dialog.

Tap Edit 
currencies
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2 Select any of the following options:

3 Tap OK to close the Show Options dialog and activate your selections.

Transferring Your Data to Microsoft Excel
After you enter your expenses into the Expense application on pdQ 
smartphone, the Palm™ Desktop software enables you to view and print the 
data with your computer. 

You need Microsoft Excel version 5.0 (or later) to view and print 
your Expense data using one of the provided templates. Microsoft 
Excel is not included with pdQ smartphone. The procedures in this 
section also assume that you have installed the Palm Desktop 
software. See “Installing Palm Desktop Software” in the pdQ Basics 
Handbook for more information.

Sort By Enables you to sort the Expense entries by date or 
expense type.

Distance Enables you to display Mileage entries in miles or 
kilometers.

Show Currency Shows or hides the currency symbol in the expense 
list.

Tap Show
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Printing an Expense Report
Palm Desktop makes it quick and easy to print your Expense data. 

To print your expense report:

1 Perform a HotSync® operation to transfer your latest Expense data to 
your computer and make it available to Palm Desktop. See the 
“HotSync” chapter for details.

2 Click Expense in Palm Desktop to open Microsoft Excel and the Expense 
Report configuration dialog. 

If you launch Expense from the Start menu (instead of Palm 
Desktop), you must first choose pdQ smartphone user name.

3 Click the expense category that you want to print. 

You can press Shift+click to select multiple categories. To print 
the expenses associated with all of your Expense categories, click 
All in the Categories area.

4 If you want to define an end date for the expense report, enter the date 
in the End Date area.

If you do not specify an end date, all expense entries for the 
selected categories will appear — up to the date of the last 
HotSync operation with pdQ smartphone.

5 Click Print to display the expense report in the Print Preview window.

Click to select 
Categories
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6 Click Print in the Microsoft Excel window to print your expense report.

To view your Expense data in a Microsoft Excel spreadsheet:

1 Perform a HotSync operation to transfer your latest Expense data to 
your computer and make it available to Palm Desktop.

2 Click Expense in Palm Desktop to open Microsoft Excel and the Expense 
Report configuration dialog.

If you start Expense from the Start menu (instead of Palm 
Desktop), you must first choose user name.

Click to select 
Categories
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3 Click the expense category that you want to use. 

You can press Shift+click to select multiple categories. If you want 
to view the expenses associated with all of your Expense 
categories, click All in the Categories area.

4 If you want to define an end date for the expense report, enter the date 
in the End Date area.

If you do not specify an end date, all expense entries for the 
selected categories will appear — up to the date of the last 
HotSync operation.

5 Click Create to display a Microsoft Excel spreadsheet containing your 
Expense data.

At this point, your Expense data appears in Microsoft Excel spreadsheet 
form. You can enter information, make formatting changes and save and 
print the file in the normal manner.

Using Expense Report Templates
Palm Desktop software comes with several expense report templates. When 
you use one of these templates, you can edit your Expense data in Microsoft 
Excel. If you want to streamline or customize your expense reports, you can 
change these templates. For example, you can add your company name to a 
template. See “Appendix A: Expense Templates” for sample templates and 
“Appendix B: Creating a Custom Expense Report” for details on changing 
templates.
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To view your Expense data using a Microsoft Excel template:

1 Display your Expense data in a Microsoft Excel spreadsheet as described 
in the previous procedure.

2 Click Options to open the Expense Report Options dialog.

3 Enter name, department and other information as necessary for your 
expense report.

4 Click the Templates menu, then click an expense template. See 
“Appendix A: Expense Templates” for samples.

If you want to create your own custom expense template and have 
it appear in the Templates menu, refer to “Appendix B: Creating a 
Custom Expense Report.”

5 Click OK to return to the Expense Report Options dialog.

Expense Menu Commands
The Expense application includes menu commands to perform common file 
and editing tasks. This section explains the menu commands that are 
specific to the Expense application.

See “Using Menus” in the pdQ Basics Handbook for information about menu 
commands that are common to all of pdQ smartphone applications.

Choose expense 
template

Enter name and 
other information
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Record Menu
When you select the Record menu, its commands appear on screen.

Delete Item Opens an alert dialog, prompting you to confirm that 
you want to delete the current expense item. You 
must tap an item before you can use the Delete Item 
command. Tap OK to delete the item from pdQ 
smartphone, or tap Cancel to close the alert dialog 
and keep the item.

By default pdQ smartphone removes the item from the 
Expense application, but retains a copy of the item 
and transfers it to an archive file on your computer 
the next time you perform a HotSync operation. To 
remove the item completely, clear the Save archive 
copy on PC check box.

Purge Conserves memory on pdQ smartphone by deleting 
expense categories that you no longer use.

The Purge command prompts you to confirm that you 
want to purge all the records from the selected 
category.
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Options Menu
When you select the Options menu, its commands appear on screen.

Preferences Activates the Preferences dialog, which is used to 
activate the automatic fill feature and to set the 
default currency symbol.

Use automatic fill Enables you to select an expense 
type by writing the first letter of an expense type in 
the Graffiti writing area. For example, if you write the 
letter “T,” it enters the “Taxi” expense type. Writing 
“T” and then “E” enters “Telephone” which is the first 
expense type beginning with the letters “TE.” 

Default currency Sets the default currency symbol for 
the Expense application. 

Custom 
Currencies

Enables you to define additional currency symbols for 
the Expense application.

You need to use this command only if the currency 
symbol you need is not available in the Currency pick 
list of the Receipt Details dialog (See “Entering 
Receipt Details” earlier in this chapter).

About Expense Shows version (revision) information for the Expense 
application.
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To define a custom currency symbol:

1 Choose Custom Currencies from the Options menu to open the Custom 
Currencies dialog.

2 Tap one of the four Country boxes to open the Currency Properties 
dialog.

3 Enter the name of the country and the symbol that you want to appear 
in the Expense application, and then tap OK to define your setting.

4 Tap OK to close the Custom Currencies dialog.

To use your custom currency symbol as the default for all Expense 
entries, choose the symbol in the Preferences dialog. To use your 
custom currency symbol only for particular expense items, choose 
the symbol in the Receipt Details dialog associated with those 
items.

Tap a Country 
button
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Chapter 7

HotSync®

HotSync® technology enables you to synchronize data between one 
or more pdQ™ smartphones and the Palm™ Desktop software. To 
synchronize data, you must connect your the pdQ smartphone cradle 

directly to your computer. 

With HotSync technology, you can:

■ Synchronize the Date Book, Address Book, To Do List, Memo Pad and 
Expense entries on pdQ smartphone with the entries on your computer, 
and vice versa.

■ Manage individual or multiple pdQ smartphones with a centralized 
computer.

■ Keep your data safe by automatically creating backup copies each time 
you synchronize.

The HotSync Technology Process and the HotSync Manager
The HotSync technology process automatically synchronizes data between 
pdQ smartphone and your computer. Changes you make on pdQ smartphone 
or computer appear in both places after a HotSync technology operation. 
HotSync technology synchronizes only the needed portions of files, thus 
reducing synchronization time. You can synchronize your data by 
connecting pdQ smartphone directly to your computer with the HotSync 
cradle or indirectly to a network. 

The HotSync Manager oversees the synchronization process. It runs in the 
background and monitors a communications port on your computer for a 
HotSync command from a pdQ smartphone. When it “hears” a HotSync 
command, HotSync Manager synchronizes data in the Date Book, Address 
Book, To Do List, Memo Pad, Mail and Expense applications. It can 
synchronize the data even when Palm Desktop is not running!

Once you complete a few simple setup steps, performing a HotSync 
technology operation is as simple as pressing a button. Follow the steps in 
the next section to complete the setup. 
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Performing a HotSync Technology Operation for the First
Time
The first time you synchronize your data, you need to enter user information 
on both pdQ smartphone and the computer. Once you enter this information 
and synchronize, the HotSync Manager recognizes pdQ smartphone and 
doesn’t ask for this information again. If you are a System Administrator 
preparing several pdQ smartphones for a group of users, see “Creating a User 
Profile” later in this chapter before performing the following steps.

To perform a HotSync technology operation for the first time:

1 Double-click the Palm Desktop icon on the Windows desktop (or select 
Palm Desktop from the Start menu) to start the Palm Desktop software.

2 Click  in the Windows System Tray to open the HotSync Manager 
menu. 

The Windows System Tray is usually in the lower-right corner on 
your computer display. The location may vary depending on the 
location of the taskbar and the version of Windows you are using.

3 Click Local from the HotSync Manager menu to indicate that you are 
using the cradle to synchronize.

4 Turn on pdQ smartphone and slide it into the cradle.

The curved edge on the bottom of pdQ smartphone should align 
smoothly with the cradle when it is inserted properly.

5 Tap  on pdQ smartphone’s screen to open the New User dialog. 

6 Enter a user name for pdQ smartphone. Then, click OK to open the 
HotSync Progress dialog and start the synchronization process. 

Every pdQ smartphone should have a unique name. Never try to 
synchronize more than one pdQ smartphone using the same user 
name.
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7 Wait for a message indicating that the process is complete.

Conducting a Local HotSync technology operation
After you complete the first HotSync technology operation, the HotSync 
technology process is even faster and easier!

To conduct a local HotSync technology operation:

1 Insert pdQ smartphone into its cradle.

2 If the HotSync Manager is not running, start it.

3 Tap  on the pdQ smartphone screen to start the HotSync technology 
process.

4 Wait for a message indicating that the process is complete.

Selecting HotSync Setup Options
You can choose when you want HotSync Manager to run, and you can adjust 
the local and modem HotSync settings.

To set the HotSync Options:

1 Click  in the Windows System Tray to open the HotSync Manager 
menu.

2 Click Setup on the HotSync Manager menu to open the Setup dialog.
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Selecting HotSync Setup Options

3 Click the General tab and select one of the following options:

If you’re not sure which option to use, keep the Always available 
default setting.

4 Click the Local tab to display the settings for the connection between 
your PC and pdQ smartphone’s cradle, then adjust the following options 
as needed.

Always available Adds HotSync Manager to the Startup folder and 
constantly monitors the communication port for 
pdQ smartphone synchronization requests. With 
this option, the HotSync Manager conducts 
synchronizations even when Palm Desktop is not 
running.

Available only 
when Palm 
Desktop is running

Starts HotSync Manager and monitors requests 
automatically when you open the Palm Desktop 
software.

Manual Starts the HotSync Manager and monitors 
requests only when you select HotSync Manager 
from the Start menu.
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5 Click the Modem tab to display the Modem settings and adjust the 
following options as needed. 

Serial Port Identifies the port Palm Desktop will use to 
communicate with the cradle. This selection 
should match the port number where you 
connected the cradle.

pdQ smartphone cannot share this port with an 
internal modem or other device. If you have 
trouble determining the correct serial port, see 
“Troubleshooting” in the pdQ Basics Handbook.

Speed Determines the speed at which data is transferred 
between pdQ smartphone and Palm Desktop. We 
suggest you try the As Fast As Possible rate first, 
and adjust downward if you experience problems. 
This setting allows pdQ smartphone and the Palm 
Desktop to find and use the fastest speed.
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6 Click OK to close the Setup dialog.

Serial Port Identifies the port where the modem is located. If 
you are unsure of the port assignment, look at the 
Modem Properties in the Windows Control Panel.

Speed Determines the speed at which data is transferred. 
We suggest you try the As Fast As Possible rate 
first, and adjust downward if you experience 
problems. This setting allows pdQ smartphone and 
the Palm Desktop to find and use the fastest 
speed.

Modem Identifies the modem type or manufacturer. Refer 
to your modem manual or face plate for its type or 
settings. If you’re not sure of your modem type or 
your modem doesn’t match any that appear in the 
list, choose Hayes Basic.

Setup String Identifies the setup string for your particular 
modem. Not all modems require a setup string. 
Refer to your modem manual and enter the setup 
string if recommended by the manufacturer.
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Customizing HotSync Application Settings
For each application you can define a set of options that determines how 
records are handled during synchronization. These options are called a 
“conduit.” By default, Palm Desktop synchronizes all files between pdQ 
smartphone and the Palm Desktop. In general, you should leave the settings 
to synchronize all files. The only reason you might want to change these 
settings is to overwrite data on either pdQ smartphone or Palm Desktop, or 
to avoid synchronizing a particular type of file because you don’t use it.

In addition to the Date Book, Address Book, To Do List, Memo Pad and 
Expense application conduits, Palm Desktop includes System and Install 
conduits. The System conduit backs up the system information stored in pdQ 
smartphone, including Graffiti® software ShortCuts. The Install conduit is 
used to install pdQ smartphone-compatible applications. 

To customize HotSync application settings:

1 Click  in the Windows System Tray to open the HotSync Manager 
menu.

You can also click the HotSync command on the Palm Desktop 
menu bar to open the HotSync Manager menu.

2 Click Custom from the HotSync menu to open the Custom dialog.

3 Select the appropriate user name from the list at the top of the dialog.

4 Click an application in the Conduit list to choose the conduit you want 
to change.

5 Click Change to open the Change HotSync Action dialog.
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6 Click the direction in which you want to write data, or click Do Nothing 
to skip data transfer for an application.

Changing the HotSync setting from the default affects only the 
next HotSync technology operation. Thereafter, the HotSync 
Actions revert to their default settings. To use a new setting on 
an ongoing basis, select the Set As Default box. Thereafter, just 
click Default in the Custom dialog to revert to the default settings.

7 Repeat steps 2 through 5 to change conduit settings for other 
applications or for a different user name.

8 Click OK to close the Change HotSync Action dialog and activate your 
settings.

Conducting HotSync technology operation via a Network
When you use the Network HotSync software, you can take advantage of the 
LAN and WAN connectivity available in many office environments. The 
Network HotSync software enables you to perform a HotSync technology 
operation using a cradle that is connected to any PC on your LAN or WAN 
(provided that the PC connected to the cradle also has the Network HotSync 
software installed and your PC is on and the HotSync Manager is running). 

Creating a User Profile
If you need to configure a number of pdQ smartphones with specific 
information (such as a company phone list) before distributing them to their 
actual users, you can create a User Profile to load the data into a pdQ 
smartphone without associating that data with a user name. The User Profile 
feature is designed only for the first-time HotSync technology operation, 
before you assign a User ID to a particular pdQ smartphone. See “Using File 
Link” later in this chapter for information about loading data after you 
assign a User ID.

pdQ Apps.book  Page 60  Monday, October 26, 1998  10:50 AM



Chapter 7 HotSync® 61
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Creating a User Profile
ExH

otSync®
H

otSync®
W

orking w
ith Phone and 

M
essaging Features 

To create a User Profile:

1 Open the Palm Desktop software.

2 Click Users from the Tools menu to open the Users dialog.

3 Click Profiles to open the Profiles dialog. 

4 Click New to open the New Profile dialog.

5 Enter a name for the Profile and click OK to return to the Profiles dialog. 

6 Repeat steps 3 and 4 for each Profile that you want to create, then Click 
OK to close the Profiles dialog and return to Palm Desktop. 

7 Select the Profile from the User list and create the data for the Profile 
(such as, company phone list).

To use a profile for the first-time HotSync technology operation:

1 Place the new pdQ smartphone in the cradle, then tap   to open the 
Users dialog.

2 Click Profiles to open the Profiles dialog.

3 Choose the profile that you want to install on pdQ smartphone, then 
click OK to open the following alert dialog:
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4 Click Yes to transfer all the Profile data to the pdQ smartphone.

The next time you perform a HotSync technology operation, Palm Desktop 
will prompt you to assign a User name to the pdQ smartphone.

Using File Link
The File Link feature enables you to synchronize the Address Book and Memo 
Pad information on pdQ smartphone with a separate external file, such as a 
company phone list. HotSync Manager stores the data in a separate category 
on your Palm Desktop and pdQ smartphone. You can configure the File Link 
feature to check for changes to the external file when you perform a HotSync 
technology operation. 
With File Link you can synchronize with data stored in any of the following 
formats:

■ Comma-separated (*.csv)

■ Memo Pad archive (*.mpa)

■ Address Book archive (*.aba)

■ Text (*.txt)

For information on how to set up a File Link, see the Palm Desktop Software 
online Help.
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Mail

The Mail application enables you to manage your e-mail. You can use 
Mail to synchronize the mail in your computer’s e-mail application 
with the mail on pdQ™ smartphone. 

pdQ smartphone is delivered with two e-mail applications: Mail 
and pdQmail. Mail lets you read, store, and delete e-mail messages 
received on your computer and to create e-mail messages. To 
transfer e-mail messages between pdQ smartphone and your 
computer, you need to perform HotSync. You cannot use Mail to 
send or receive e-mail messages from pdQ smartphone.

If you delete messages from pdQ smartphone using Mail, your next HotSync® 
operation also deletes the messages from your computer’s e-mail 
application — so you never have to delete messages twice. Similarly, if you 
read a message on pdQ smartphone and leave it in your inbox, your next 
HotSync operation marks it as read on your computer’s e-mail.

pdQmail is the most powerful and versatile e-mail application available for 
the Palm III operating system. You can use pdQmail to send, receive, create, 
and manage e-mail messages directly from pdQ smartphone. This capability 
makes it easier than ever to stay in touch with the added convenience that 
only a wireless hand-held smartphone provides.

With Mail, you can:

■ Use your pdQ smartphone to send and retrieve e-mail messages from 
your computer’s e-mail application.

■ View, delete, file and reply to incoming mail.

■ Create outgoing messages as well as drafts of messages that you can 
complete later.

■ Create simple or complex filters, which allow you to decide the type of 
e-mail that your pdQ smartphone retrieves from your computer’s e-mail 
application.

To open Mail:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Message List screen.
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Setting Up Mail on the Desktop

Before you use Mail for the first time, your computer’s e-mail application 
should be up and running. You must also set up the pdQ™ Desktop software 
for use with your computer’s e-mail application. 

The following instructions assume that you have already installed 
Palm Desktop software on your computer and that you did not set 
up Mail during the installation. If you have not yet installed the 
Palm Desktop software, the installation procedure will prompt you 
to set up Mail as part of the Palm Desktop software installation.

To set up Mail:

1 Click Start on the Windows computer’s to open the Start menu.

2 Point to Programs, point to Palm Desktop, and then click Mail Setup to 
start the setup procedure.

3 Follow the instructions on the screen to set up pdQ smartphone for use 
with your computer’s e-mail application.

To select HotSync options:

1 Click  in the Windows System Tray to open the HotSync menu. 

2 Click Custom from the HotSync menu to open the Custom dialog.

You can also click Custom from the HotSync menu in Palm 
Desktop.

3 Click Mail in the Custom list box.

4 Click Change to open the Change HotSync Action dialog.
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5 Click one of the following settings:

To turn off mail, select Do Nothing and then select the Set as 
Default check box.

To change your Mail setup options:

1 Click  in the Windows System Tray to open the HotSync menu. 

2 Click Custom from the HotSync menu to open the Custom dialog.

Synchronize 
the files

Synchronizes the mail on pdQ smartphone and your 
computer’s e-mail application.

Desktop 
overwrites 
handheld

Replaces the mail on pdQ smartphone with the mail in 
your computer’s e-mail application. You should use 
this option only if, for some reason, the two inboxes 
get out of sync. This setting applies for only one 
HotSync operation and then reverts back to the 
default setting.

Do Nothing Turns off communication between your pdQ 
smartphone and computer’s e-mail application. This 
setting applies for only one HotSync operation and 
then reverts back to the default setting.

Set As 
Default

Changes the default setting on an ongoing basis. 
(When you first set up Mail, Synchronize the files is 
the default setting.)

pdQ Apps.book  Page 65  Monday, October 26, 1998  10:50 AM



66 pdQ Applications Handbook
QUALCOMM Proprietary PRELIMINARY - 10/26/98, 80-68789-1 Rev X2

Synchronizing Mail with your E-Mail Application

You can also click Custom from the HotSync menu in Palm 
Desktop.

3 Click the Mail in the Conduit list to indicate that you want to change 
these settings.

4 Click Change to open the Change HotSync Action dialog for the Mail 
conduit.

5 Modify your settings as needed.

6 Click OK to confirm your changes and close the Change HotSync Action 
dialog.

Synchronizing Mail with your E-Mail Application

After you have enabled and configured Mail, you need to perform a HotSync 
operation to synchronize Mail with your computer’s e-mail application. For 
a complete explanation of how to use the HotSync feature, see the 
“HotSync” chapter.

Viewing Messages

The Message List lists your incoming messages, who sent them and the date 
they were received. Messages you’ve read appear with a check next them and 
high-priority messages appear in bold.

To open a message:

Tap a message in the list to open it.

Previously read

▼
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Messages appear by default in the abbreviated mode. To switch from the 
abbreviated mode to the full header mode, see “Displaying Full Header 
Information” later in this chapter.

To close a message:

Tap Done to close the message and return to the Message List.

Message Fonts

You can modify the way messages appear by changing the font (text) style. 
See “Choosing Fonts” in the pdQ Basics Handbook for details. 

Displaying Full Header Information

By default, Mail displays abbreviated header information. The abbreviated 
header displays only the From and Subject fields. The full header provides 
complete information about the sender, receiver and CC recipients, in 
addition to the subject and date the message was created. Mail uses the 
header type you select for all your messages.

To display full header information:

1 Open a message.

2 Tap Complete Header to display the full header.

Recipient
Sender

Time and date sent

Message body

Subject

Header mode icons

▼
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To redisplay the abbreviated header, tap the Abbreviated Header 
icon.

Creating Messages

You create messages with pdQ smartphone the same way you create 
messages with your computer’s e-mail application: you identify the 
recipient(s) of the message, define a subject and create the body of the 
message.

You create original messages and replies in the New Message screen. All 
messages must, at the very least, contain information in the To and Subject 
fields. 

To create a message:

1 Tap New in the Message List screen to display the New Message screen.

You can also display the New Message screen by tapping New from 
the Message menu.

2 Use the stylus to write Graffiti® character strokes (or the on-screen 

Complete Header icon

Abbreviated Header icon

Tap New
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keyboard) to enter the e-mail address of the recipient. The cursor 
indicates where new text will appear.

Enter the address as if you are entering it from your computer’s e-
mail application. For example, network users sending a message 
to a user on the same network do not need to add Internet 
information, such as @3com.com.

3 To send a carbon copy of this message to additional recipients, tap in 
the CC field, then enter the e-mail addresses of the additional 
recipients, separating the addresses with a comma followed by a space.

4 Tap in the Subj field, then enter a subject for your message. 

5 Tap in the Body field, then enter the body text.

If the address, CC, subject or body of the message exceeds the 
capacity of the screen display, tap the name of the field (for 
example, “To”) to expand that field. Tap the Done button to return 
to the New Message screen.
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To reply to a message:

1 Tap a message in the Message List to display it on the screen.

2 Tap the Reply button to open the Reply Options dialog.

3 Select who you want to receive the reply: only the Sender, All recipients 
and the sender or do you want to Forward the message to someone else.

4 Select whether you want to Include original text and Comment original 
text.

5 Tap OK to close the Reply Options dialog and display the New Message 
screen.

6 Enter your reply text.

You have several message options including setting the priority. 
See “Adding Message Details” for details.

7 Tap Send to place your reply in the Outbox.

Looking Up an Address

To identify the recipient of a message, you need to enter that person’s e-
mail address in the appropriate field of the Message screen. You can do this 

Tap to return to New Message screen

Tap the name of the field to open
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either by entering the data directly into the field or by using the Look Up 
command to access the information in your Address Book. 

To look up an address:

1 Tap either the To or CC field name to expand one of these fields.

2 Enter a few letters of the address you want to find. 

3 Tap Lookup. 

4 If the letters you enter identify a unique listing from your Address Book, 
pdQ smartphone completes the address for you. If not, the Lookup 
dialog appears.

You can also open the Look Up dialog in the New Message screen 
by tapping Lookup from the Options menu or by using the 
Command stroke /L. 

5 Enter the first letter of the entry you want to find to scroll to the first 
entry that begins with that letter. If you write an additional letter, the 
list scrolls to the first entry that starts with those two letters. For 
example, writing an “s” might scroll to “Sanders,” and writing “sm” 
might scroll farther to “Smith.”

6 Tap an address to select it.

7 Tap Add to enter the address in the To or CC field.

Tap here
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Adding Message Details

Before you send your message, you can attach additional attributes (called 
message details) to your message, such as a signature block, or flagging the 
message as high-priority. These features are dependent on the computer’s 
e-mail application you use. If your e-mail application does not support the 
selected message detail, pdQ smartphone cannot attach that attribute to 
your message.

The following message details are available:

The Priority and BCC settings are valid only for the current 
message and must be set with each subsequent message you 
create.

Priority Flags a message as high, normal or low priority.

BCC Creates a blind carbon copy field in the New Message 
screen. 

Signature Attaches previously defined text as a signature block. See 
“Adding a Signature to Your Message” later in this 
chapter for details.

Confirm Read Requests a confirmation telling you when the message 
was read.

Confirm 
Delivery

Requests a confirmation telling you when the message 
was delivered.

Tap here to enter address in field

Tap to select

pdQ Apps.book  Page 72  Monday, October 26, 1998  10:50 AM



Chapter 8 Mail 73
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Adding Message Details
Experiencing the pdQ™

 
Advantage

Getting Started
W

orking w
ith Organizer 

Features
M

ail
Setting a Priority

To set a priority for your message:

1 Tap Details in the New Message screen to open the Message Details 
dialog.

2 Tap the Priority pick list and select the priority you want.

3 Tap OK to confirm your selection and return to the New Message screen.

pdQ smartphone can flag messages with a specific priority only if 
your computer’s e-mail application supports this feature.

Sending a Blind Carbon Copy

To add a BCC field to your message:

1 Select the BCC check box in the Message Details dialog to add the BCC 
field to the New Message screen. 

2 Tap OK to confirm your selection and return to the New Message screen.

Tap here

Tap here

Tap to select priority
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3 Tap the BCC field and enter the address. 

Adding a Signature to Your Message

Adding a signature to your message is a two-part process: first, you must 
create your signature, then you must select the signature option from the 
Message Detail dialog.

To create a signature:

1 Tap the  icon to open the Mail menus.

2 Tap Preferences from the Options menu to open the Preferences dialog.

3 Tap in the Signature Text field and enter up to six lines of text. 

4 Tap OK to confirm your selection and return to the previous screen.

To add a signature to your message:

1 Tap Details in the New Message screen to open the Message Details 
dialog.

2 Select the Signature check box to add a signature to the end of your 
message. 

3 Tap OK to confirm your selection and return to the New Message screen.

BCC field

Add signature 
text here
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The signature block does not display in your message; only your 
recipient sees the signature block.

Requesting Confirmations

To receive a confirmation when your message is read:

1 Tap Details in the New Message screen to open the Message Details 
dialog.

2 Select the Confirm Read check box to request a confirmation when the 
recipient reads your message. 

3 Tap OK to confirm your selection and return to the New Message screen.

To receive a confirmation when your message is delivered:

1 Tap Details in the New Message screen to open the Message Details 
dialog.

2 Select the Confirm Delivery check box to request a confirmation that the 
recipient received your message. 

3 Tap OK to confirm your selection and return to the New Message screen.

Sending Messages

When you send Mail messages from pdQ smartphone, it stores them in the 
Outbox folder until the next time you synchronize pdQ smartphone with your 
computer. During synchronization, all messages stored in the Outbox folder 
are transferred to the Outbox folder in your computer’s e-mail application. 
Messages created on pdQ smartphone are transmitted the next time you 
send mail from your computer’s e-mail application.

To send a message:

After you create a message, tap the Send button in the New Message 
screen. 

Editing an Unsent Message

You can edit or make changes to a message that has not yet been sent, as 
long as you have not yet performed a HotSync operation. When you edit a 
message, pdQ smartphone removes the message from the Outbox folder and 
takes you back to the New Message screen, where you can edit the message 
and resend it, save it as a draft or cancel it.

To retrieve a message:

1 In the Message List screen, tap Outbox from the pick list in the upper-

▼
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Draft Messages

right corner to display the messages contained in the Outbox.

2 Tap the message you want to retrieve to display the message.

3 Tap Edit to remove the message from the Outbox folder and place it 
back in the New Message screen.

Draft Messages

There are times when you may not want to immediately send a message you 
compose — for example, you may want to add additional information before 
sending it. pdQ smartphone stores such messages in the Draft folder until 
you are ready to edit them. When you edit a draft, it becomes a new message 
again.

When you’re creating or editing a message, you can also save a 
message as a draft by canceling it. When you cancel a message, 
pdQ smartphone opens a dialog asking if you want to save the 
message. If you tap Yes, pdQ smartphone saves a draft of your 
message.

Tap to display folder list
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To save a message as a draft:

1 Create a message in the New Message screen.

2 Tap  to open the Mail menus.

3 Tap Save Draft from the Message menu to move the message to the Draft 
folder.

To edit a message saved as a draft:

1 In the Message List screen, tap Draft from the pick list in the upper-
right corner to display a list of the messages in the Draft folder.

2 Tap the draft you want to display.

3 Tap Edit to move your draft to the New Message screen.

4 Enter your changes, then either save it again as a draft or tap the Send 
button to move the message to your Outbox folder.

Filing a Message

pdQ smartphone can store any message you receive or create in the Filed 
folder. The contents of this folder do not automatically synchronize with 
your computer’s e-mail application during a HotSync operation. However, 
pdQ smartphone does store a back-up copy of the Filed folder on your 
computer hard drive.

To file a message:

1 Open a message.

2 Tap  to open the Mail menus.

3 Tap File from the Message menu to display the Message File Options 
dialog.

4 Tap No to save the message and move it to the Filed folder or tap Yes 
to file the message and keep a copy in the Inbox.

Tap here to 
select 
message

Tap to edit 
draft in 
New      
Message 
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To remove a message you created from the Filed folder:

1 In the Message List screen, tap Filed from the pick list in the upper-
right corner to display the contents of the Filed folder.

2 Tap the message you want to restore. 

3 Tap Edit to display and modify the message.

After you display and modify the message, you can send it, save 
it as a draft, or return it to the Filed folder.

Deleting Messages

pdQ smartphone stores deleted message in the Deleted folder until you 
synchronize pdQ smartphone with your computer. If you delete a message 
from pdQ smartphone, it is deleted on your computer’s e-mail application 
after synchronization.

To delete a message:

1 Open the message you want to delete.

2 Tap Delete. 

3 If you selected the Preference option to confirm message deletion, tap 
Yes to confirm that you want to delete the current message. 

Removing a Message From the Deleted Folder

You can reverse the deletion of a message (by removing it from the Deleted 
folder) as long as you have neither performed a HotSync operation nor 
purged the contents of the Deleted folder.

To remove a message you received from the Deleted folder:

1 In the Message List screen, tap Deleted from the pick list in the upper-
right corner to display the contents of the Deleted folder.

2 Tap the message you want to restore. 

3 Tap Undelete to move the selected message to the Inbox and mark it as 
read.

To remove a message you created from the Deleted folder:

1 In the Message List screen, tap Deleted from the pick list in the upper-
right corner to display the contents of the Deleted folder.

2 Tap the message you want to restore. 

3 Tap Edit to display and modify the message.

After you display and modify the message, you can send it or save 
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Purging Deleted Messages

Because pdQ smartphone stores deleted messages in the Deleted folder until 
you perform a HotSync operation, deleted messages can monopolize storage 
space. To avoid or correct this problem, you can purge the contents of your 
Deleted folder. Messages that you purge will still delete from your 
computer’s e-mail application during the next HotSync operation.

To purge the contents of the Deleted folder:

1 Tap  to open the Mail menus. 

2 Tap Purge Deleted from the Message menu.

3 When pdQ smartphone displays the Purge Deleted Messages alert, tap 
Yes to confirm that you want to purge the contents of the Deleted 
folder. 

You cannot restore messages after you purge them.

Message List Options

Message List Options enable you to manage the way the Message List 
displays information.

Folders

pdQ smartphone provides five different folders, each pertaining to a 
particular mail category. The Message List displays the messages in the 
folder you select. Folders provide an efficient way to manage the mail you 
send and receive.

To select a folder:

1 Tap the pick list in the upper-right corner to open the following list of 
folders:

Inbox Contains the mail from your computer’s e-mail application 
Inbox, minus any that you have excluded using filtering 
options. See “Creating Special Filters” later in this chapter for 
details.

Outbox Contains the mail you created and sent on pdQ smartphone 
since the last HotSync operation.
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2 Tap to select the folder you want to display in the Message List screen.

Date Column

The Date Column is optional in the Message List. By default, the Date 
Column is hidden to increase the available screen space. 

To show the Date Column:

1 Tap Show in the Message List to open the Show Options dialog.

2 Select the Show Date check box to show the Date Column. 

3 Tap OK to close the Show Options dialog and return to the Message List.

Sorting the Message List

You can sort the Message List by the date it was sent, by the sender or by 
the subject.

High-priority messages always appear first, no matter how you 
sort your message list.

To sort the Message List:

1 Tap Show in the Message List to open the Show Options dialog.

2 Tap the Sort by pick list and select one of the following options:

Deleted Contains the messages you deleted since the last HotSync 
operation.

Filed Contains the messages you want to store on pdQ smartphone.

Draft Contains the messages you created using pdQ smartphone but 
are not yet ready to send.

Tap Show
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3 Tap OK to close the Show Options dialog and return to the Message List. 

HotSync Options

HotSync Options enable you manage your e-mail more effectively by 
selecting which messages download when you synchronize your computer 
and pdQ smartphone. You can define different settings for local and remote 
synchronization. For example, you may want to download all of your 
messages during local synchronization and only urgent messages during 
remote synchronization. Once defined, pdQ smartphone determines if 
synchronization is occurring locally or remotely and uses the appropriate 
HotSync Options settings.

To activate the HotSync Options dialog:

1 Tap  to open the Mail menus.

2 Tap HotSync Options from the Options menu to open the HotSync 
Options dialog.

3 Tap the Settings for pick list and select Local HotSync or Remote 
HotSync.

Date Sorts messages by date and displays the most recent 
message at the top of the screen.

Sender Sorts messages by the sender’s user name and displays 
them in ascending alphabetical order —based on the 
first word of the sender field.

Subject Sorts messages by the subject and displays them in 
ascending alphabetical order — based on the first word 
of the subject field.

Tap here 
to display 
HotSync 
options 
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For more information about Local and Remote HotSync operations, 
see the “HotSync” chapter.

4 Tap the filtering option you want to apply. The following filtering 
options are available:

The All setting does not mean that all information included in 
each message downloads to pdQ smartphone. Truncation settings 
(explained in a following section) for long messages still apply. 
Also, Mail never downloads any attachments to pdQ smartphone. 
The message and any text information appear, but the attachment 
is left in your computer’s e-mail application.

5 If you selected All, Send Only or Unread, tap OK to confirm your 
selection and close the HotSync Options dialog. If you selected Filter, 
continue to the next section.

Creating Special Filters

You can create special filters to control the type of messages that download 
to pdQ smartphone during synchronization. Special filters work on the 
premise of ignoring or retrieving messages that contain specific information 

All During synchronization, all of the messages in your 
computer’s e-mail Inbox synchronize with pdQ 
smartphone and all messages in your pdQ smartphone 
Outbox are sent to your computer’s e-mail application.

Send Only During synchronization, only the messages in the pdQ 
smartphone Outbox are sent to your computer’s e-mail 
application where they are sent to their final 
destination.

Filter During synchronization, all messages in the pdQ 
smartphone Outbox are sent to your computer’s e-mail 
application, and messages in your computer’s e-mail 
Inbox that meet specific criteria download to pdQ 
smartphone. When you select the Filter setting, the 
HotSync Options dialog opens and displays additional 
filter settings. See “Creating Special Filters” for details.

Unread During synchronization, only unread messages download 
to pdQ smartphone from your computer’s e-mail Inbox, 
and all messages in your pdQ smartphone Outbox are sent 
to your computer’s e-mail application.
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in their header fields. 

To create a special filter, you must decide whether you want to ignore or 
retrieve certain messages. Then, based on that decision, you must tell your 
pdQ smartphone what it needs to look for in the To, From, and Subject 
header fields to single out those messages. 

To access the special filter settings:

Tap the Filter box in the HotSync Options dialog to display the filter 
settings.

Ignoring or Receiving Messages

The first step in establishing a special filter is to determine whether you 
want to ignore or retrieve messages that match the information you specify.

To define whether to ignore or receive messages:

Tap the pick list in the center of the HotSync Options dialog and select 
one of the following settings:

▼

Tap to dis-
play Filter 
options

▼

Select Filter option

Tap here 
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Defining Filter Strings

Messages are filtered based on the information contained in their To, From 
and Subject header fields. The information that defines what pdQ 
smartphone is looking for is called a filter string. You create a filter string 
by listing the words you want pdQ smartphone to find and separating them 
with either a comma or a space. Each word in the filter string is joined by 
an implicit OR; because of this, you should not enter connecting words such 
as AND or OR.

To create a more complex filter, you can define filter strings for the To, From 
and Subject fields simultaneously. pdQ smartphone joins the filter strings 
for these fields using an implicit AND. Once again, you should not add 
connecting words. pdQ smartphone will do that for you.

For example, suppose you want to receive only messages from John Smith 
(jsmith@aol.com) or Jack Jones (jjones@aol.com) concerning the Apollo 
Project. You would create the following filter strings:

To field filter string: jsmith@aol.com, jjones@aol.com

Subject field filter string: Apollo Project

pdQ smartphone interprets this as, “Accept messages about the Apollo 
Project from John Smith or Jack Jones. Do not accept messages from other 
people. Do not accept messages from John or Jack about any other subject.”

When you define a string, note that pdQ smartphone searches for any 
instance of that collection of characters. For example, if you create a filter 
that retrieves only messages containing the string “info,” pdQ smartphone 

Ignore 
Messages 
Containing

Tells your pdQ smartphone to exclude the messages 
that meet the defined criteria and download all other 
messages during synchronization. In general, this 
filter downloads more mail during synchronization 
because it blocks only one defined subset of mail.

Retrieve 
Only 
Messages 
Containing

Tells your Palm III organizer to include only the 
messages that meet the defined criteria and to ignore 
all other messages during synchronization. This filter 
has the potential to block more mail during 
synchronization because it downloads only one subset 
of mail.
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considers “info,” “rainforest” and “kinfolk” appropriate matches.

To define filter strings:

1 Tap a header field in the HotSync Options dialog. 

2 Enter your filter string for the selected header field using commas or 
spaces to separate the words. Do not add connecting words, such as 
AND or OR, between words in a string.

3 If your string exceeds the length of the field, tap the name of the field 
to display the Notes screen for that header field. For more information 
about header field Notes screens, see “Creating Messages.”

4 Tap Done to return to the HotSync Options dialog.

5 Tap OK to confirm your filter strings and close the HotSync Options 
dialog.

High-Priority Messages

The Retrieve All High Priority setting lets you retrieve messages marked 
high-priority, even if those messages would have been blocked by a defined 
filter.

Tap here 
to insert 
cursor

Tap here 

Tap Done 
to return to 
HotSync 
Options

Enter 
filter data
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To retrieve high-priority messages:

1 Tap the Filter box in the HotSync Options dialog to display additional 
filter options.

2 Select the Retrieve All High Priority check box to retrieve all messages 
marked high-priority. 

3 Tap OK to confirm your selection and close the HotSync Options dialog.

This setting is applicable only if your e-mail application has the 
capacity to flag high-priority messages.

Truncating Messages

The Truncate feature lets you set a point at which long messages truncate 
when downloading to pdQ smartphone. By default, this Truncate value is 
4000 characters. By truncating long messages, you reduce the time it takes 
to synchronize your computer’s e-mail and Mail as well as the amount of 
storage space e-mail uses on pdQ smartphone.

Truncation is separate and independent from filtering.

To truncate messages:

1 Tap Truncate in the HotSync Options dialog to open the Truncate 
Options dialog.

Tap 
check 
box
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2 Tap to select the truncation setting you want. The values range from 
250 characters to 8000 characters.

If you select a low truncation value, you will have more room on 
pdQ smartphone to store messages.

3 Tap OK to confirm your selection and return to the HotSync Options 
dialog.

Mail Menu Commands

The Mail application includes menu commands to make it fast and easy to 
perform common file and editing tasks. This section explains the menu 
commands that are specific to the Mail application.

See “Using Menus” in the pdQ Basics Handbook for information about menu 
commands common to all pdQ smartphone applications.

Message Menu

The Message menu varies based on whether you are viewing a message, 
creating a message or viewing the Message List.

Tap 
Truncate 

Tap to se-
lect maxi-
mum length

Message List

New Message 

View Message
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Options Menu

When you select the Options menu, its menu commands vary depending on 
whether you are creating or editing a message.

New Displays the Create Message screen, where you can create a 
new e-mail message.

Save Draft Saves the current message as a draft and moves it to the 
Draft folder. pdQ smartphone Draft messages until you send 
or delete them.

File Moves the current message to the Filed folder. pdQ 
smartphone stores Filed messages until you delete them.

Send Moves the current message to the Outbox folder. pdQ 
smartphone stores all sent messages in the Outbox folder 
until you perform a HotSync operation.

Delete Moves the current message to the Deleted folder. pdQ 
smartphone stores deleted messages in the Deleted folder 
until you perform a HotSync operation, at which time it 
permanently removes deleted messages.

Purge 
Deleted

Enables you to empty (purge) the contents of the Deleted 
folder. pdQ smartphone deleted messages in the Deleted 
folder until you perform a HotSync operation. By purging 
deleted messages, you free up storage space on pdQ 
smartphone before your next HotSync operation.

The Purge Deleted command displays an alert, prompting 
you to confirm that you want to purge all messages from the 
Deleted folder. If you tap Yes, all deleted messages are 
purged from the memory of pdQ smartphone.

Messages that you purge are deleted from your computer’s 
e-mail application during the next HotSync operation.

Message List
New Message
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Font Enables you to adjust the size of the text on the screen. 
This can make it easier to read the text or to fit more 
text in the display area.

Preferences Enables you to define a specific string of text as a 
signature and to select whether or not pdQ smartphone 
displays an alert when you delete a message.

HotSync 
Options

Opens a dialog, where you can select different ways to 
filter messages synchronized between your computer’s 
e-mail application and pdQ smartphone. You can create 
simple or complex filters to control the type of 
messages downloaded to pdQ smartphone. In addition, 
you can define separate settings for local and remote 
synchronizations.

Look Up Opens a dialog, which contains the Address List from 
your Address Book. By tapping a selection, you enter 
that address into the To field of any message you are 
creating.

The Look Up command is available only when you are 
creating a message.

About Mail Shows version (revision) information for the Mail 
application.
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Memo Pad

The Memo Pad provides a place to take notes that are not associated 
with Date Book, Address Book or To Do items.

With the Memo Pad, you can:

■ Take notes or write any kind of message on your pdQ™ smartphone. 

■ Drag and drop memos into popular computer applications like Microsoft 
Word, when you synchronize using Palm™ Desktop software and 
HotSync® technology.

■ Assign categories for memos. This enables you to quickly view just your 
business-related memos, personal memos or any other category that 
you define.

■ Quickly jot down phone numbers and other types of information. Later, 
you can copy and paste this information to other applications. 

To open the Memo Pad:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Memo List screen.

Working With Memos
A memo is where you enter, review and modify the individual Memo Pad 
entries. A memo can contain up to 4,000 characters; the number of memos 
you can store is dependent only on the memory available on pdQ 
smartphone. 
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To create a new memo:

1 Tap  to display the Memo List screen.

2 Tap New to create a new memo.

In the Memo List screen, you can also begin writing in the Graffiti® 
writing area to create a new memo. The first letter is automatically 
capitalized and begins your new memo.

3 Enter the text you want to appear in the memo. Use the carriage return 
stroke to move down to new lines in the memo.

4 After you finish, tap Done to return to the Memo List screen. 

Reviewing Memos
Each time you create a memo, the first line of the memo appears in the 
Memo List screen. This makes it easy to locate and review your memos.

To review the contents of a memo:

1 Tap the text of the memo that appears in the Memo List screen to 
display the memo on the screen.

2 Review or edit the text in the memo. 

Tap New

Tap a 
memo to 
review its 
contents
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3 Tap Done to save your changes to the memo and return to the Memo 
List screen.

Arranging Memos
The Memo Preferences dialog enables you to sort your memos alphabetically 
or in any order that you want. 

To select a sort option:

1 Tap  to open the Memo Pad menus in the Memo List screen.

2 Tap Preferences from the Options menu to open the Memo Preferences 
dialog. 

3 Tap the Sort by pick list and choose Manual or Alphabetic.

4 Tap OK to close the Memo Preferences dialog and activate your setting.

Manually Arranging the Memo List
If you choose the Manual option for the Sort by setting, you can manually 
rearrange the order of the memos in the Memo List screen. When you 
rearrange your memos, pdQ smartphone renumbers all the memos to reflect 
the new order.

The Manual setting of the Memo Preferences is not transferred to 
Palm Desktop. If you choose to display your memos alphabetically 
on Palm Desktop and then perform a HotSync operation, the 
arrangement of the memos on pdQ smartphone will still be in the 
order defined in the Memo Preferences setting.

To rearrange the order of your memos:

1 Select the Manual option in the Preferences dialog as described in the 
previous procedure.

2 In the Memo List screen, tap and drag the memo to a new location in 
the list. When you lift the stylus from pdQ smartphone’s screen, the 
memo appears in its new location.

Choosing a Memo Category
Categories are used to file individual memos items into groups for easy 
review. You can assign and edit categories by using the Categories pick list 
(in the upper-right corner of the screen) or the Details dialog. See “Using 
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Marking a Private Memo

Categories” in the pdQ Basics Handbook for a complete description of 
categories. 

Marking a Private Memo
You can designate a specific memo as “private.” When you activate the 
Security features, pdQ smartphone hides all private entries and you must 
enter a password to display them on the screen. 

To mark a memo as private:

1 Tap the memo you want to mark as private to display it on the screen.

2 Tap Details to open the Memo Details dialog for that memo.

3 Select the Private check box.

4 Tap OK to close the Memo Details dialog and return to the memo screen.

Deleting a Memo
There are three ways to delete a memo: simply delete the text of the memo, 
use the Menu Command (as described in the “Record Menu” section in this 
chapter) or use the Memo Details dialog.

To delete a memo with the Memo Details dialog:

1 Tap the memo that you want to delete to display it on the screen.

2 Tap Details to open the Memo Details dialog.

3 Tap Delete to open the Delete Memo alert.

4 Tap OK to confirm that you want to delete the current memo.
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Memo Pad Menu Commands
The Memo Pad includes menu commands to make it fast and easy to perform 
common file and editing tasks. See “Using Menus” in the pdQ Basics 
Handbook for information about menu commands common to all pdQ 
smartphone applications.

Record Menu
When you select the Record menu, its commands appear on screen.

New Memo Creates a new memo.

Delete Memo Opens an alert dialog, prompting you to confirm that 
you want to delete the current memo. Tap OK to 
delete the memo from pdQ smartphone, or tap Cancel 
to close the alert dialog and keep the memo.

By default pdQ smartphone removes the memo from 
the Memo List, but retains a copy of the memo and 
transfers it to an archive file on your computer the 
next time you perform a HotSync operation. To 
remove the memo completely, clear the Save archive 
copy on PC check box.

Beam Memo Beams the current memo to another pdQ smartphone 
through the IR port.

Beam Category Beams all memos in the current category to another 
pdQ smartphone through the IR port. 

Memo List
Memo screen
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Memo Pad Menu Commands

Options Menu
When you select the Options menu, its commands appear on screen.

Font Opens the Select Font dialog where you can choose 
a different font (text) style for your Memo Pad 
entries. See “Choosing Fonts” in the pdQ Basics 
Handbook for details.

Go to Top of Page Moves to the top (first) line of the memo.

Go to Bottom of 
Page

Moves to the bottom (last) line of the memo.

Phone Lookup Activates the Phone Lookup feature, which is 
described in “Using Phone Lookup” in the pdQ 
Basics Handbook.

Preferences Activates the Memo Preferences dialog and 
enables you to define the sort order for your 
memos. 

About Memo Pad Shows version (revision) information for the Memo 
Pad application.

Memo List

Memo screen
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Chapter 10

pdQ SMS

pdQ SMS lets you know if you have received text or pager 
messages and whether or not your voice mailbox contains voice 
mail. Your service provider gives you the number to call to check 
for voice mail, which is entered in Phone Preferences. Chapter 2 

Getting Started in the pdQ Basics Handbook explains how to define phone 
preferences.

With pdQ SMS, you can:

■ Distinguish between read and unread messages. All unread messages 
appear in bold while read messages appear as plain text. 

■ Learn whether or not your voice mail box contains voice mail messages.  

■ Respond to text and pager messages directly.

To open pdQ SMS:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to open pdQ SMS.

To return a page:

1 Open the keypad, then tap  on the pdQ smartphone screen to turn on 
the phone.

2 Tap  to open pdQ SMS.

3 Tap the call back phone number. 
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To check for voice mail:

1 Open the keypad, then tap  on the pdQ smartphone screen to turn on 
the phone.

2 Tap  to open pdQ SMS.

3 Tap the voice mail line entry number. 

To remove all entries in pdQ SMS:

 Tap Purge to remove all acknowledged messages from pdQ SMS.▼
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Chapter 11

pdQmail

Welcome to pdQmail™, the most powerful and versatile e-mail 
application available for the Palm III™ operating system. You can use 
pdQmail to send, receive, create, and manage e-mail messages directly 
from the pdQ smartphone. This capability makes it easier than ever to 
stay in touch with the added convenience that only a wireless 

smartphone you can hold in one hand provides.

pdQ smartphone is delivered with two e-mail applications: Mail 
and pdQmail. Mail lets you read, store, and delete e-mail messages 
received on your computer and to create e-mail messages. To 
transfer e-mail messages between pdQ smartphone and your 
computer, you need to synchronize the pdQ smartphone and your 
computer. You cannot use Mail to send or receive e-mail messages 
from pdQ smartphone.

Before using pdQmail to send or receive e-mail messages, you need to 
define:

■ Modem preferences

■ Network preferences

■ pdQmail preferences

pdQmail preferences include adding a signature to your e-mail messages and 
setting a priority. For detailed information, see the pdQ Basics Handbook.

With pdQmail, you can:

■ Write, send, forward, and receive e-mail messages using pdQ 
smartphone.

■ Define up to 15 mailboxes for storing e-mail you send or receive.

■ Include a personal signature and other details in your e-mail messages. 

■ Limit the number of lines in e-mail messages that display on the pdQ 
smartphone screen. 

pdQ Apps.book  Page 99  Monday, October 26, 1998  10:50 AM



100 pdQ Applications Handbook
QUALCOMM Proprietary PRELIMINARY - 10/26/98, 80-68789-1 Rev X2

Starting pdQmail and Disconnecting From the Network

To open pdQmail:

Open the keypad, then tap  to display the pdQmail In mailbox. 

Starting pdQmail and Disconnecting From the Network

To start pdQmail:

1 Open the keypad, then tap  to turn on the phone.

2 Tap  to open the Applications Launcher.

3 Tap  to display the last screen you worked on. 

To disconnect from the network:

1 While in pdQmail, tap . 

2 Tap Disconnect from the Mail menu.

Checking For and Viewing E-mail Messages

The Message List lists incoming messages, who sent them, and the date they 
were received. After your mail is delivered, it is listed by e-mail name, 
subject, and date. You need to select and open your mail messages. 

To check for e-mail messages:

1 Tap  from pdQmail.

2 Tap Check Mail from the Mail menu.

A progress window shows your dial-up and service connection 
progress. 

To open an e-mail message:

Tap to select the message in the desired mailbox. 

▼

Identifies the open mailbox
▼
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Displaying Complete Header Information
By default, pdQmail displays abbreviated header information. The 
abbreviated header displays only the From and Date fields. The complete 
header includes the From, Date, Subject, and Cc fields. The same header type 
displays for all messages.

To display complete header information:

1 Open an e-mail message.

2 Tap H in the upper right corner of the screen.

To display the abbreviated header, tap h. 

Creating E-mail Messages
You create e-mail messages with pdQmail the same way you create messages 
with your computer’s e-mail application: you identify the e-mail 
recipient(s), define a subject, and write the e-mail.

You create messages and replies in the Message Composition screen. All 
messages must, at the very least, contain a valid e-mail address in the To 
field. It is also a good idea to include a subject. 

When writing or editing an e-mail message, use the Edit menu to 
Undo, Cut, Copy, Paste, and Select All. 

To create an e-mail message:

1 From pdQmail, tap  to display pdQmail menus at the top of the 
screen.

2 Tap New Message from the Mail menu to display the Message 
Composition screen.

Tap to display the complete header

Tap to display the abbreviated header
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Creating E-mail Messages

3 Tap the To line, then use the stylus to write Graffiti® script or use the 
on-screen keyboard to enter the e-mail address of the recipient. 

To send a copy of this message to additional recipients, tap the Cc 
line, then enter the e-mail address for each additional recipient. 
Be sure to separate each address with a comma followed by a 
space.

4 Tap the Subj line, then enter a subject for your e-mail message. 

5 Tap the Body line, then enter the body text.

6 Tap Send to either place the e-mail message in your Out mailbox or send 
it immediately when pdQ is connected to the network.

To extend the screen display:

If the To or Cc field requires more space than what is available, you can 
extend the screen display.

1 Tap the field name (for example, “To”) to expand that field. 

2 Enter the appropriate information.

3 Tap Done to return to the Message Composition screen.

Tap New

Tap the name of the field to open it
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Looking Up an Address
You can look up a recipient’s e-mail address from the Address Book directly. 
You can either tap Lookup or use the Command stroke /L from the Message 
Address screen. 

To look up an address:

1 Tap the To or CC field name to expand the field.

2 Enter a few letters of the address you want to find on the first line, then 
tap Lookup. 

3 If the letters you enter identify a unique listing from your Address Book, 
pdQ smartphone completes the address for you. If not, the Lookup 
dialog appears.

4 Tap an address to select it.

5 Tap Add to enter the address in the To or Cc field.

Tap To or Cc to open the screen 

Tap here
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Sending Messages

Sending Messages
When you send messages from the pdQ smartphone, it stores them in the 
Out mailbox folder until you either establish a network connection or the 
next time you synchronize the pdQ smartphone with your computer. 

To send a message:

Tap Send in the Message Composition screen after you create a 
message. 

To send a blind carbon copy (Bcc) e-mail message: 

You can forward a copy of all e-mail messages you send to someone without 
other e-mail recipients knowing it. 

1 Tap  to display pdQmail menus at the top of the screen.

2 Tap Options, then Mail Sending Options to display the Mail Sending 
Preferences screen. Then tap More Prefs.

Tap here to enter address in field

▼

Tap here
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Replying to E-mail Messages

You can respond to an e-mail message directly or forward it to others.

To reply to a message:

1 Tap the message you want to respond to.

2 Tap Reply to open the Reply Options dialog.

3 Tap Reply to only respond to the Sender. Tap Reply to all to reply to the 
sender and all recipients receiving a copy of the message. 

You have several message options to choose from, such as setting 
a priority for the e-mail message. See “Adding Message Details” 
earlier in this chapter for more information.

4 Enter your response or edit the content as needed.

5 Tap Send to place your reply in the Out mailbox. 

Forwarding a Message

You can forward any message you receive to someone else. 

To forward a message:

1 In the open message, tap Forward. A new message window is displayed 
with your address, the original subject trailed by “Fwd,” and the 
original sender’s text quoted in the message body.

2 Make any changes you want, and enter the recipient’s address in the To 
field. The message can then be sent or saved in the Out mailbox for 
further changes.

 If you forward an outgoing message, attachments received are 
never included. 

Closing E-mail Messages

To close an e-mail message:

Tap Done to close the message and return to the Message List.▼
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Deleting Messages

Deleting Messages

To delete a message:

1 Open the message you want to delete.

2 Tap Delete. 

The message is transferred to your Trash mailbox. When you delete 
messages from the Trash, it is deleted from your pdQ smartphone.

Disconnecting from the Server

After sending and receiving e-mail messages, you need to disconnect from 
the server.

To disconnect from the server:

Tap , then Disconnect from the Mail menu.

Changing Your Password

These instructions explain how to change the password on the server.

To change your password when checking for mail:

1 To display pdQmail menus at the top of the screen, tap .

2 Tap Options, then Change Password to display the dialog below. 

3 In the Old password field, enter your current password.

4 In the New password field, enter you new password.

5 Click OK. pdQmail connects to the server and changes your password.

Working with Mailboxes

Mailboxes contain all of your incoming and outgoing message header 
information. When you first start pdQmail, the In mailbox displays with its 
list of messages. The In, Out, and Trash mailboxes are included with 
pdQmail. You can create more mailboxes if you need them. 

▼
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Creating Mailboxes

You can create up to 15 mailboxes for storing e-mail messages you send and 
receive. Once you open a message, you can file it in a mailbox.

To create a mailbox:
1 Open an e-mail message, then tap .

2 Tap File in Mailbox from the Message menu.

3 Tap New Mailbox from the Mailbox list.

4 Tap the New Mailbox line, then enter the name of the new mailbox.

5 When finished, tap OK.

Displaying the Mailbox List

You can display your list of mailboxes from any mailbox. The number of 
messages within each mailbox appears in parentheses to the right of the 
mailbox name.

To display the list of mailboxes:

1 Start pdQmail.

2 Tap  next to a mailbox name.
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Working with Mailboxes

Filing a Message in a Mailbox
Once you have created mailboxes, you can transfer any message you retrieve 
to a mailbox of your choice. 

To file a message in a mailbox:

1 Tap to select and open a message.

2 Tap  to open the pdQmail menus.

3 Tap Message, then File in Mailbox. 

4 To transfer the message, tap the mailbox displayed in the list. The 
message is transferred to that mailbox.

Sorting E-mail Messages
You can sort incoming e-mail by date, sender, subject, grouped subject, or 
priority. High-priority messages always appear first, no matter how you sort 
your messages in a mailbox.

To sort your messages in a mailbox:

1 Tap  to the left of the mailbox whose e-mail messages you want to 
sort. 

2 Tap , then Mail.

3 Tap Sorting/Columns.
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4 Tap Sort by  to display the list of sorting options:

5 Tap the sort option you want to use, then tap OK when finished.

If you want to display the day an e-mail message was sent or 
received, check the Show Date check box.

6 When finished, tap OK.

Deleting E-mail Messages from a Mailbox

To delete all of the messages in a mailbox:

1 Open the mailbox that contains the messages you want to delete.

2 Tap , then Mail.

3 Tap Delete All in Mailbox.

All of the messages are placed in the Trash. Empty the Trash to 
permanently delete the email-messages from pdQ smartphone. 

To empty the Trash:

1 Tap , then Mail.

2 Tap Empty Trash.

Date Sorts messages by date and displays the most recent 
message at the top of the screen.

Sender Sorts messages by the sender’s user name and displays 
them in ascending alphabetical order —based on the first 
word of the sender field.

Subject Sorts messages by the subject and displays them in 
ascending alphabetical order — based on the first word of 
the subject field.

Grouped 
Subject

Sorts messages by group, then groups are sorted by date 
(oldest to current).

Priority Sorts by priority (highest to lowest).
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pdQmail Shortcuts
pdQmail includes shortcuts that give you quick access to menu options. 
Shortcuts, entered using Graffiti script, appear to the right of applicable 
menu options.

To use a shortcut:

Write / and then the letter that corresponds to the shortcut you want 
to use in the left side of the Graffiti writing area.

Managing pdQmail Attachments
If an incoming message includes an attachment, pdQmail displays only the 
name and file extension of the file but will not deliver the attachment 
because of the file size limitation of the pdQ smartphone. Attachment 
information is usually at the end of a message. If there is more than one file 
attached to the message, pdQmail provides information only on the first 
one. You need to open attachments from the application after downloading 
them to your computer. 

Working with Different Types of Text
pdQmail displays plain, “text/enriched,” and Hyper Text Markup Language 
(HTML) text and saves it until you perform HotSync. pdQmail also:

■ Converts HTML to plain text

■ Handles sets and encodings for U.S. English and many European 
languages

■ Handles a limited amount of Unencode (an encoding type)

When sending HTML formatted e-mail, usually two copies of the message are 
included, the first in plain text, the second in HTML formatted text. When 
pdQmail encounters this, it displays the text version of the message if the 
HTML formatted text has not been completely retrieved. Then, if you retrieve 
the rest of the message, the message text you see won’t change, but you 
will see the added HTML formatted text.

▼

pdQ Apps.book  Page 110  Monday, October 26, 1998  10:50 AM



Chapter 11 pdQmail 111
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Getting Help
Experiencing the pdQ™

 
Advantage

Getting Started
pdQM

ail
W

orking w
ith Phone and 

M
essaging Features 

Getting Help
In pdQmail, tap  in the upper-right corner of the window to display help 
text. Click the up or down arrow on the lower-right to display more help text. 
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Getting Help
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Chapter 12

Web

The pdQ smartphone web application, Web, is one of QUALCOMM’s 
newest wireless communications solutions. It defines a new 
Internet browser standard and gives you quick access to Internet 
sites. Web makes moving between sites and scrolling through 

documents a snap. As an added bonus, internet searches exclude banners 
and graphics, which saves you time. Once Web is set up, it takes only a 
couple of taps to visit an Internet site anywhere in the world!

Before searching the Internet, you need to define:

■ Modem preferences

■ Network preferences 

You also need to establish an account for network services with an Internet 
Service Provider (ISP). The pdQ Basics Handbook lists the information the 
ISP provides.

With Web, you can:

■ Create an unlimited number of bookmarks (web addresses).

■ Sort web site bookmarks by categories.

■ Navigate the web using a scroll bar and hotlinks.

You can use the Web to perform operations like these:

■ Tap the scroll bar on the right of the screen to scroll through text.

■ Tap the arrows on the bottom of the screen to move forward and 
backward.

■ Tap bold text to visit a different site.

Here are a few more tips for getting around:

■ Tap Details to learn more about a site.

■ Tap Bookmark this Page to add a bookmark.

■ Tap Refresh this Page to reload the site.
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Starting and Disconnecting from the Internet

To start Web:

1 Open the keypad, then tap  to turn on the phone.

2 Tap  to display the Applications Launcher.

3 Tap  to display the web’s Bookmark screen.

  If a web page displays, tap the Bookmarks button at the bottom 
of the screen. 

To disconnect from the Internet:

While in Web, tap  to close it then  to turn off the phone. 

Adding, Editing, or Deleting a Bookmark

To add a bookmark: 

1 Tap  from the Applications Launcher to display the Bookmarks 
screen. 

If you are connected to your server, the last Internet site you 
accessed appears instead of the Bookmarks screen. To display the 
Bookmarks screen, tap Bookmarks at the bottom left of the screen.

2 To set up a new web address, tap New to open the Create Bookmark 
dialog box.

▼

Tap New
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3 In the URL field, enter the name for the web site you wish to access (for 

example, CNN). The www and the .com are automatically added to the 
name. Notice that the name you enter in the URL field appears in the 
Name field. You may edit this field if you wish. Whatever appears in the 
Name field appears in the bookmark list on the Bookmarks screen. 

The content of the Name field appears in the bookmark list on the 
Bookmarks screen.

4 Tap  to open the Edit Categories dialog.

5 Select the category that best describes this web site. There are a few 
preset categories, but you may add, delete, or rename categories at any 
time by selecting Edit Categories from the Category drop-down menu. 
The Edit Categories screen displays. 

6 Tap the category you want to assign to the bookmark, then tap OK.

7 To add a new category, tap New; or to edit a category, select it and tap 
Edit. The Edit Categories dialog box appears prompting you to enter the 
name of the new category or edit the existing category.

8 When finished, tap OK.

On the Bookmarks screen, notice  at the top-right of the screen. 
Tap the arrow to display the drop-down category list, and you can 
choose the category of the bookmarks you want to display. Also, 
if you tap Edit Categories, the Edit Categories screen displays.
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Connecting to the Internet

To edit a bookmark:

1 Tap  that corresponds to the bookmark you want to edit.

2 Edit the information you want to change, then tap OK when finished.

To delete a bookmark:

1 Tap  that corresponds to the bookmark you want to delete.

2 Tap Delete, then tap OK twice.

Connecting to the Internet

Once you have defined bookmarks, you are now ready to connect to the 
Internet and to the bookmark’s particular web site. You can also connect to 
the Internet using an address that is not set up as a bookmark. This is done 
via a menu option.

Connecting Using a Bookmark

You can connect directly to the Internet from one of your preset bookmarks.

 To connect to the Internet using a bookmark:

On the Bookmarks screen, tap the name of the bookmark. The Service 
Connection Progress screen shows the progress of the phone connection.

If you don’t have a bookmark set up for a certain web address, you 
can still access its page.

Connecting Using an Address that Is Not a Bookmark

To access a web site without using a Bookmark:

1 To turn on the phone, tap  on the pdQ smartphone screen.

2 To display web menus at the top of the screen, tap .

3 From the Options menu, tap Visit Location.

4 The cursor is positioned between the two periods in the URL field. Enter 
the name of the web site.

▼
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5 Tap OK. The Service Connection Progress screen shows the progress of 

the phone connection. Once connected to the Internet, you should be 
at the desired web site.

Copying Text from an Internet Site to Applications

You can copy information from an Internet site and paste it into any 
application that supports cut and paste operations.

To copy text from an Internet site to an application:

1 Tap and drag across the text you want to copy to highlight it.

2 Tap , then tap Edit.

3 Tap Copy to place the highlighted text on the pdQ smartphone 
clipboard. 

4 Launch an application that supports cut and paste operations, then tap 
where you want to insert the text. 

5 Tap Edit, then paste to insert the copied text. 

Setting Up Web Preferences

You can set up how much cache memory you want on the pdQ smartphone 
to control your access speed to the Internet.

To display the Web Preferences dialog box:

1 To display Web menus at the top of the screen, tap .

2 From the Options menu, choose Preferences.

3 In the Maximum Cache Size field, enter the memory size of the cache. 
If you want to delete the cache, tap Delete Cache. 

4 When finished, tap OK.
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Disconnecting from the Internet

Disconnecting from the Internet

Remember to disconnect form the Internet when you are finished searching.

To disconnect from the Internet:

1 To display Web menus at the top of the screen, tap .

2 Tap Options, then tap Disconnect to end your Internet session.

Web Shortcuts

Use shortcuts, which appear to the right of each menu option, to display 
menus and menu options. To perform a shortcut, draw a diagonal line from 
the bottom-left to the top-right of the graffiti area of your pdQ smartphone, 
then write the appropriate letter. 

To use a Shortcut:

Write / and then the letter that corresponds to the Shortcut you want 
to use in the left side of the Graffiti writing area. 

Getting Help
In the Web application, tap  from the upper-right corner of the dialog box 
to get help. Tap the up or down arrow on the lower-right to display more 
help text. 

Web

▼
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Chapter 13

Preferences

The Preferences screens enable you to customize the configuration 
options on your pdQ™ smartphone. If you want to define a 
preference that is not described in this chapter, refer to the pdQ 

Basics Handbook.

With the Preferences screens, you can:

■ Set the current date and time, the auto shut-off interval, and the 
system, alarm and game sounds.

■ Set the display format for dates, times and numbers.

■ Assign your name, phone number and other owner information to pdQ 
smartphone.

■ Assign different applications to the buttons on the front panel of 
pdQ smartphone.

■ Define a list of Graffiti® abbreviations.

■ Align the screen on pdQ smartphone.
■ Configure pdQ smartphone for use with a network.

To open the Preferences screens:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the last Preferences screen you used. 

3 Tap the pick list in the upper-right corner to select the Preferences 
screen you want to view.
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Buttons Preferences

Buttons Preferences
The Buttons Preferences screen enables you to associate different 
applications with the buttons on the front of pdQ smartphone. 

For example, if you find that you seldom use the To Do List application and 
often use the Expense application, you can assign the To Do List button to 
start the Expense application.

Any changes you make in the Buttons Preferences screen become effective 
immediately; you do not have to change to a different screen or application.

If you assign a different application to a button, you can still access the 
original application using the Applications Launcher. See “Selecting 
Applications” in the pdQ Basics Handbook.

To change the Buttons Preferences:

1 Tap the pick list next to the button you want to assign in the Buttons 
Preferences screen to display a list of all the applications installed on 
pdQ smartphone.

2 Tap the application that you want to assign to the button.

To restore all of the buttons to their factory settings, tap the 
Default button.

Pen Preferences
The Buttons Preferences screen enables you to change the Button 
assignment of the full-screen pen stroke. By default, the full-screen pen 
stroke activates the Graffiti Help dialog.

Tap arrow to 
show pick list
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To change the Pen preferences:

1 Tap Pen in the Buttons Preferences screen to open the Pen dialog.

2 Tap the pick list and select one of the following settings for the full-
screen pen stroke:

Backlight Activates the backlight feature of pdQ 
smartphone. You can use this setting instead of 
the power button to turn the backlight on and off.

Keyboard Activates the on-screen keyboard for entering text 
characters.

Graffiti Help Activates a series of screens that show the 
complete Graffiti pen stroke character set.

Drag to top of screen
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Digitizer Preferences

3 Tap OK to complete your selection and return to the Buttons Preferences 
screen.

HotSync® Buttons Preferences

Any changes that you make in the HotSync Buttons dialog become effective 
immediately; you do not have to change to a different screen or application.

To change the HotSync Buttons preferences:

1 Tap HotSync in the Buttons Preferences screen to open the HotSync 
Buttons dialog.

2 Tap the pick list next to the button you want to assign to display a list 
of all the applications installed on pdQ smartphone.

3 Tap the application that you want to assign to each button. The default 
setting for each button is the HotSync setting, which means the cradle.

Digitizer Preferences
The Digitizer Preferences screen activates the digitizer calibration screen. 
This is the same screen that appears when you start pdQ smartphone for the 
first time. A complete description of how to use the digitizer calibration 
screen appears in the “Aligning the Screen” section in the pdQ Basics 
Handbook.

Turn Off & Lock Turns off and locks pdQ smartphone. You must 
assign a password to lock pdQ smartphone. When 
locked, you need to enter the password to use pdQ 
smartphone.

Beam Data Beams the current entry to another pdQ 

smartphone.

Tap arrow to 
show pick 
list
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Formats Preferences
Use the Formats Preferences screen to set the display format of the dates, 
times and numbers on pdQ smartphone. 

Country Default
The country default sets date, time, week start day, and number conventions 
based on geographic regions where you might use pdQ smartphone. For 
example, in the United Kingdom, time often is expressed based on a 24-hour 
clock. In the United States it is based on a 12-hour clock with an AM or PM 
suffix.

All pdQ smartphone applications use the Country default settings. You can, 
however, customize your own preferences as described in the “Time, Date, 
Week Start and Numbers Formats” section later in this chapter.

To set the country default:

1 Tap the country name in the Formats Preferences screen to open the 
Country pick list.

2 Tap the setting you want to use. 

Time, Date, Week Start and Numbers Formats
The Time setting defines the format for the time of day. The time format 
that you select appears in all applications on pdQ smartphone. 

To select the Time, Date, Week start and Numbers format:

1 Tap the Time pick list in the Formats Preferences screen, and select the 
format that you want for pdQ smartphone. 

2 Tap the Date pick list and select the format you want to use.

3 Tap the Week starts pick list and select whether you want the first day 
of the week to be either Sunday or Monday. 
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General Preferences

This setting controls the Day, Week and Month views in the Date 
Book application and all other aspects of pdQ that display a 
calendar.

4 Tap the Numbers pick list and select the format that you want for pdQ 
smartphone.

General Preferences
The General Preferences screen is where you set the time, date, auto shut-
off interval and sounds for pdQ smartphone. 

Auto-Off Delay

pdQ smartphone has an automatic shutoff feature that turns off the power 
and backlight after a period of inactivity. This feature helps conserve battery 
power in case you forget to turn off pdQ smartphone.

If you find that pdQ smartphone shuts itself off before you finish reviewing 
the information on the screen, you should increase the time setting of the 
automatic shutoff feature.

To set the Auto-off delay:

1 Tap the Auto-off after setting in the General Preferences screen to open 
the pick list. 

2 Tap the setting you want to use for the automatic shutoff feature. You 
can choose a delay of 1 minute, 2 minutes or 3 minutes. 

System, Alarm and Game Sounds
pdQ smartphone uses a variety of sounds. The System, Alarm and Game 
Sound settings enable you to turn the sounds on or off, and to adjust the 
volume level.

To set the system and alarm sounds:

1 Tap the System Sound pick list in the General Preferences screen and 
select the sound level. 

When you turn off the System Sounds, you also turn off the 
“chime” tones associated with the HotSync operation. 

2 Tap the Alarm Sound pick list and select the sound level. 

3 Tap the Game Sound pick list and select the sound level.

The Game Sound setting works only with games that are 
programmed to respond to this setting. Older games typically do 
not respond to this setting. 
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Working with Service Templates

The pdQ Basics Handbook describes how to define fields for service template.

Creating Additional Service Templates
You can create additional service templates from scratch or by duplicating 
existing templates and editing information. After you create a new or 
duplicate template, you can add and edit settings.

To add a new service template:

1 Tap  in the Network Preferences screen to open the menus.

2 Tap New from the Service menu to create a new service template (called 
Untitled) to the Service pick list and display it in the Network 
Preferences screen.

To duplicate an existing service template:

1 Tap the Service pick list in the Network Preference screen to open a list 
of all the predefined service templates.

2 Tap the service you want to duplicate.

3 Tap  to open the Network Preferences menus.

4 Tap Duplicate from the Service menu to add a copy of the service 
template to the Service pick list and display it in the Network 
Preferences screen.

Deleting a Service Template
There is only one way to delete a service template: use the Delete command 
from the Service menu.

To delete a service template:

1 Tap the Service pick list in the Network Preference screen to open a list 
of available service templates.

2 Tap the service you want to delete.

3 Tap  to open the menus for the Network Preferences screen.

4 Tap Delete from the Service menu to display the Delete Service alert.

5 Tap OK to confirm that you want to delete the service template.

Network Preferences Menu Commands
The Network Preferences screen includes menu commands to make it fast 
and easy to create and edit service templates. This section explains the 
menu commands that are specific to the TCP/IP application.
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Network Preferences Menu Commands

See “Using Menus” in the pdQ Basics Handbook for information about menu 
commands that are common to all of pdQ smartphone applications.

Service Menu

When you select the Service menu, its commands appear on screen.

Options Menu

When you select the Options menu, its command appears on screen:

TCP/IP Troubleshooting
If you are having a problem establishing a network connection using TCP/
IP, check this section and try the suggestions listed.

Displaying expanded Service Connection Progress messages

It’s helpful to identify at what point in the login procedure the connection 
fails. An easy way to do this is to display the expanded Service Connection 
Progress messages. Expanded Service Connection Progress messages 
describe the current stage of the login procedure. Press the lower half of the 
Scroll button at any point during login to display these messages.

Viewing the Network Log

If viewing the expanded Service Connection Progress messages does not 
give you enough information to find out why you cannot connect to your 
ISP or dial-in server, take a look at the Network Log. The Network Log lists 
all of the communication that occurs between your modem and your dial-in 
server during the login procedure. The information in the Network Log can 

New Creates a new (empty) service template and adds it to the 
Service pick list.

Delete Deletes a selected service template from the Service pick list.

Duplicate Copies the selected service template and adds it to the 
Service pick list.

View Log Displays the Network Log screen
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help your ISP or your System Administrator pinpoint where the login 
procedure communication fails and why.

To view the Network Log:

1 From the Network Preferences screen, tap View Log from the Options 
menu to display the Network Log screen.

2 Tap the up and down arrows of the scroll bar to see the entire Network 
Log.

3 After you finish, tap Done to return to the Network Preferences screen.

Adding a DNS Number
If your ISP or dial-in server requires a DNS number and you did not enter 
that information in the Network Preferences screen, it will appear that you 
successfully logged into your network. However, when you try to use an 
application or look up information, the connection fails. If this occurs, try 
adding a DNS number. Ask your ISP or your System Administrator for the 
correct Primary and Secondary DNS IP numbers.

Owner Preferences
Use the Owner Preferences screen to record a name, company name, phone 
number or other information you want to associate with pdQ smartphone.

If you use the Security application to turn off and lock pdQ smartphone with 
a password, information that you put in the Owner Preferences displays the 
next time you turn on pdQ smartphone. See “Security” for more information.

To enter the Owner Preferences:

Enter the text you want to associate with pdQ smartphone in the Owner 
Preferences screen. If you enter more text than will fit on one screen, 
a scroll bar automatically appears on the right side of the screen.

If you assign a Password (with the Security application), the information in 

▼
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ShortCuts Preferences

the Owner Preferences screen “locks” and cannot be changed. In this case, 
an Unlock button appears at the bottom of the screen. 

To unlock the Owner Preferences screen:

1 Tap Unlock in the Owner Preferences screen to open the Unlock Message 
dialog.

2 Enter the password that you defined in the Security application, and tap 
OK.

ShortCuts Preferences
The ShortCuts Preferences screen enables you to define abbreviations for 
entering text with Graffiti. This section describes how to create, edit and 
delete a ShortCut. For details on the use of ShortCuts, see the “Graffiti 
ShortCuts” section in “Writing With the Stylus” in the pdQ Basics Handbook. 

Creating a ShortCut
You can create a ShortCut for any words, letters or numbers. All ShortCuts 
you create appear on the list in the ShortCut Preferences screen. All the 
ShortCuts are available in any of pdQ smartphone applications and are 
backed up on your computer when you perform a HotSync operation.

To create a ShortCut:

1 Tap New in the ShortCut Preferences screen to open the ShortCut Entry 
dialog.

2 On the ShortCut name line, enter the letters you want to use to activate 
the ShortCut.

3 Tap the ShortCut Text area and enter the text that you want to appear 
when you write the ShortCut characters.

4 Tap OK to close the ShortCut Entry dialog and define your ShortCut.

Tap New
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To use a ShortCut, draw the ShortCut stroke followed by the 
ShortCut characters. The ShortCut symbol appears at the insertion 
point and indicates you are in ShortCut mode.

Editing a ShortCut
After you create a ShortCut, you can modify it at any time.

To edit a ShortCut:

1 Tap the ShortCut you want to edit in the ShortCuts Preferences screen.

2 Tap Edit to display the ShortCut Name and ShortCut text in the ShortCut 
Entry dialog.

3 Make the changes you want and tap OK.

Deleting a ShortCut
If you no longer need a ShortCut, you can delete it from the list of 
ShortCuts.

To delete a ShortCut:

1 Tap the ShortCut you want to delete in the ShortCuts Preferences 
screen.

2 Tap Delete to display an alert dialog.

3 Tap Yes to confirm that you want to delete your ShortCut.
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Chapter 14

Security

Your pdQ™ smartphone comes with a Security application so that 
unauthorized users cannot view the entries you wish to protect.  Use 
Phone Preferences to define security for the pdQ smartphone. 

With the Security application you can:

■ Hide record entries you mark as “Private.” You can hide private entries 
with or without a password. Without a password, private entries are 
hidden until you set the Security application to show them. With a 
password, you must enter the password to view the private entries.

■ Turn off and lock pdQ smartphone so that it does not operate until you 
enter the correct password.

To open the Security application:

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Security screen. 

To assign a password:
You can assign a password to protect your private entries and to lock pdQ 
smartphone.

1 Tap the Password box in the Security screen to open the Password 
dialog.
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Hiding Private Entries

2 Enter the password that you want for pdQ smartphone. 

3 Tap OK to open a confirmation dialog. 

4 Enter the same password a second time, and tap OK to assign that 
password to pdQ smartphone.

Hiding Private Entries
You can hide the entries that you mark as private. If you assign a password, 
you must enter it to show entries you mark as private. Note that pdQ 
smartphone merely hides the entries; it does not delete them.

To hide Private entries:

1 Tap the Hide box in the Security screen to open the Hide Records dialog.

2 Tap the Hide box to hide entries you mark Private and to close the Hide 
Records dialog. 

Showing Private Entries
After you hide Private entries, you can use the Security application to 
display them again.

Tap here

Tap here
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To show Private entries:

1 Tap the Show box in the Security screen. 

If you did not assign a password, your Private entries should be 
visible. If you did assign a password, the Show Private Records 
dialog appears.

2 Enter your password. 

3 Tap the Show box to close the Show Private Records dialog and display 
Private entries in pdQ smartphone applications.

Locking pdQ Smartphone
You can also lock pdQ smartphone, so that you need to enter your password 
to operate it.

If you lock pdQ smartphone as described in the following 
procedure, you need to enter the exact password to re-activate 
pdQ smartphone. If you forget the password, you need to use the 
reset button to resume using pdQ smartphone. Using the reset 
button deletes all the entries in pdQ smartphone; however, you 
can restore all synchronized data at the next HotSync® operation. 
For information about how to use the reset button, see “Resetting 
pdQ Smartphone” in the pdQ Basics Handbook.

To lock pdQ smartphone with a password:

1 Use the HotSync application to synchronize the data between pdQ 
smartphone and your computer. 

2 Assign a password as described in “Assigning a Password” earlier in this 
chapter.

3 Tap the Turn Off & Lock Device button in the Security screen to open 
the System Lockout dialog.

Tap here
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Changing or Deleting a Password

4 Tap the Off & Lock button to turn off the power for pdQ smartphone.

5 Start pdQ smartphone and enter the password. 

Changing or Deleting a Password
Once you define a password for pdQ smartphone, you can change or delete 
it at any time. You must enter the current password before you can change 
or delete it.

To change or delete your password:

1 Tap the Assigned box in the Security screen to open the Password 
dialog.

2 Enter the current password. 

3 Tap OK to open a dialog that prompts you for a new password.

Tap here

Tap here
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4 To change the password, enter the new password and tap OK. To delete 
the password, tap Delete.

Recovering from a Forgotten Password
If you forget your password, you can delete the password from pdQ 
smartphone. Deleting a forgotten password also deletes all entries and files 
marked as Private.

If you synchronize with your computer before deleting a forgotten 
password, pdQ smartphone restores your private entries the next 
time you perform a HotSync operation, but it does not restore the 
password.

To delete a forgotten password:

1 Tap the Forgotten Password button in the Security screen to open the 
Delete Password dialog.

2 Tap Yes to delete the password, as well as all records and entries marked 
“Private.”
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Recovering from a Forgotten Password
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Chapter 15

Speed Dialer

The Speed Dialer stores a list of up to 99 phone numbers taken from 
the Address Book. When you change an entry in the Address Book, 
pdQ smartphone updates the Speed Dialer list automatically. Before 
you can use the Speed Dialer list, you need to first enter information 

in the Address Book and then add it to the Speed Dialer.

With the Speed Dialer, you can:

■ Create a list of frequently called numbers linked directly from the 
Address Book. 

■ Access the list using the keypad, Dialer, and Volume Control buttons in 
addition to the Speed Dialer application.

Using the Speed Dialer

To open the Speed Dialer:

Open the keypad, then tap  to open the Speed Dialer.

To add a phone number to the Speed Dialer list:
The Speed Dialer list consists of information linked from the Address Book. 
Before defining the Speed Dialer list, you need to enter information in the 
Address Book. 

▼
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Using the Speed Dialer

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Address List screen.

3 Tap the line that contains the contact information you want to add to 
the Speed Dialer list, then tap Edit.

4 Tap the plus sign (+) that appears to the right of the phone number you 
want to add to the Speed Dialer list, then tap Done. 

5 Tap  to open the Applications Launcher.

6 Tap  to display the Speed Dialer list and confirm the new Speed 
Dialer list entry.

To make a call from the Speed Dialer:  

1 Open the keypad, then tap  to turn on the phone.

2 Tap  to open the Applications Launcher.

3 Tap  to display the Speed Dial list.

4 Tap the line for the phone number you want to call, then tap Dial.

5 Tap End when finished.

To delete a phone number from the Speed Dialer list: 

1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the Address List screen.

3 Tap the line that contains the contact information you want to remove 
from the Speed Dialer list, then tap Edit.

4 Tap the minus sign (-) that appears to the right of the phone number 
you want to remove from the Speed Dialer list, then tap Done. 

5 Tap  to open the Applications Launcher.

To adjust the width of columns in the Speed Dialer list: 

Tap and drag  at the top of the columns to adjust column width.▼ ▼

▼
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To Do List

The To Do List is a convenient place to create reminders and 
prioritize the things that you have to do.

With the To Do List, you can:

■ Make a quick and convenient list of things to do.

■ Assign a priority level to each task.

■ Assign a due date for any or all of your To Do items. 

■ Assign a category for any, or all of your To Do items. You can then view 
your To Do List based on category (such as Business or Personal).

■ Sort To Do items either by due date, priority level or category.

■ Attach notes to individual To Do items for a description or clarification 
of the task.

To open the To Do List:
1 Open the keypad, then tap  to open the Applications Launcher.

2 Tap  to display the To Do List screen.
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Working With To Do Items
A To Do item is a reminder of some task that you have to complete. pdQ 
smartphone gives you control over the appearance, level of detail and the 
sort order of To Do items.

To create a To Do item:

1 Tap New in the To Do List screen to add an item to the list.

2 Enter the text you want to appear in the To Do item. The text can be 
longer than one line.

3 Tap anywhere on the screen to de-select the To Do item.

If no To Do item is currently selected, writing in the Graffiti® 
writing area automatically creates a new To Do item.

Setting Priority
Priority settings for To Do items enable you to arrange the tasks in your To 
Do List according to relative levels of importance. The default setting for the 
To Do List is to arrange To Do items by priority and due date, with priority 
1 items at the top. If you have a number of To Do items in your list, 
changing an item’s priority setting may move its position in the list. 

When you create a new To Do item, its Priority is automatically set 
to level “1,” the highest (most important) level. However, if you 
select a To Do item first, the new item appears beneath the 
selected item with the same priority as the selected item. 

Using the Priority feature is optional.

Tap New

New To 
Do item
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To set a Priority level for a To Do item:

1 Tap the Priority number on the left side of the To Do item to open the 
Priority pick list.

2 Tap the Priority number that you want to set for the To Do item (1 is 
most important and 5 is least important).

You can also change the Priority setting for a To Do item with the 
To Do Details dialog described later in this chapter.

Checking Off a To Do Item
The To Do List makes it easy to mark tasks as you complete them. You can 
set the To Do List to record the date that you complete the To Do item and 
you can choose to show or hide complete To Do items. See “To Do Show 
Options” later in this chapter.

To check off a To Do item:

Tap the check box on the left side of the To Do item.

Tap to 
select 
priority

Tap here

▼

Completed To 
Do item
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To Do Item Details
The To Do Item Details dialog enables you to change individual To Do item 
settings. 

To activate the To Do Item Details dialog:

1 Tap anywhere on the text of a To Do item in the To Do List screen.

2 Tap Details to open the To Do Item Details dialog.

The following sections describe the features and settings that are available 
in the To Do Item Details dialog.

Choosing a To Do Category
Categories can help you file individual To Do items into groups for easy 
review. You can assign and edit categories by using the Categories pick list 
in the Details dialog (see “Using Categories” in the pdQ Basics Handbook). 

Setting a Due Date
You can associate a due date with any To Do List item. You can also sort the 
items that appear in the list based on their due date.

To set a Due Date for a To Do List Item:

1 Tap “No Date” in the Details dialog to open the Due Date pick list.

2 Tap the Due Date that you want to assign the To Do item. The following 
choices are available:

Today Assigns the current date.

Tomorrow Assigns tomorrow’s date.

Tap here
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3 Tap OK to confirm your selection and close the To Do Details dialog.

If you turn on the Show Due Dates option in the To Do Show 
options dialog, you can tap directly on the due date in the To Do 
List to open the pick list shown in step 2. 

Deleting a To Do Item
There are three ways to delete a To Do item: simply delete the text of the 
To Do item, use the Menu Command (as described in the “Record Menu” 
section in this chapter), or use the To Do Details dialog.

To delete a To Do item with the To Do Details dialog:

1 Tap anywhere in the text area of the To Do item that you want to delete.

2 Tap Details to open the To Do Item Details dialog.

3 Tap Delete to open the Delete To Do alert dialog.

4 Tap OK to confirm that you want to delete the To Do item.

To Do Show Options
The Show Options dialog enables you to control the appearance of the To Do 
List application.

To change the Show Options settings:

1 Tap Show in the To Do List screen to open the To Do Preferences dialog.

One week later Assigns the date exactly one week from the 
current date.

No Date Removes the due date from the To Do item.

Choose date Opens the Due Date dialog where you can chose 
any due date that you want for the To Do item.
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2 Select any of the following settings:

3 Tap OK to confirm your selections and close the dialog.

To Do List Menu Commands
The To Do List includes menu commands to perform common file and editing 
tasks. See “Using Menus” in the pdQ Basics Handbook for information about 
menu commands common to all pdQ smartphone applications.

Sort by Enables you to sort the To Do items in one of the 
following ways: 

■ Priority, Due Date

■ Due Date, Priority

■ Category, Priority

■ Category, Due Date

Show Completed 
Items

Displays your complete To Do items in the To Do 
List. If you turn off this setting, your To Do items 
disappear from the list when you complete (check) 
them.

Show Only Due 
Items

Shows only the To Do items that are currently due, 
past due or have no due date specified in the To 
Do List. When this setting is active, To Do items 
that are not yet due do not appear in the list until 
their due date.

Record 
Completion Date

Replaces the due date with the completion date 
when you complete (check) the item. If you do not 
assign a due date to an item, the completion date 
still records when you complete the item.

Show Due Dates Displays the due dates associated with To Do items 
in the To Do List screen, and displays an 
exclamation mark next to incomplete To Do items 
after the due date passes.

Show Priorities Shows the priority numbers for the To Do items in 
the To Do List screen.

Show Categories Shows the category for each To Do item on the far 
right of the To Do List screen.
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Record Menu
When you select the Record menu, its commands appear on screen.

Options Menu

Delete Item Opens an alert dialog, prompting you to confirm that 
you want to delete the current To Do item. You must 
select a To Do item before you can delete it. Tap OK 
to delete the To Do item from pdQ smartphone, or tap 
Cancel to close the alert dialog and keep the To Do 
item.

By default pdQ smartphone removes the item from the 
To Do list, but retains a copy of the item and transfers 
it to an archive file on your computer the next time 
you perform a HotSync® operation. To remove the 
event completely, clear the Save archive copy on PC 
check box.

Attach Note Opens the To Do Note dialog where you can create a 
note for the current To Do item.

Delete Note Opens an alert dialog, prompting you to confirm that 
you really want to delete the note attached to the To 
Do item. You must select a To Do item before you can 
delete its note. Tap Yes to delete the Note from the 
memory of pdQ smartphone, or tap No to close the 
alert dialog and return to the To Do List.

Purge Deletes To Do items that you mark (check) as 
complete. All complete To Do List items remain in the 
To Do List until you use this command. The default 
setting is “Save archive copy on PC.” This removes 
complete To Do items from the To Do List, but retains 
copies and transfers them to an archive file on your 
computer the next time you perform a HotSync 
operation.
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When you select the Options menu, its commands appears on screen.

Beam Item Beams the current To Do item to another pdQ 
smartphone through the IR port.

Beam Category Beams all To Do Items in the current category to 
another pdQ smartphone through the IR port. 

Font Displays the Select Font dialog where you can choose 
a different font (text) style for your Address Book 
entries. See “Choosing Fonts” in the pdQ Basics 
Handbook for details.

Phone Lookup Activates the Phone Lookup feature, which is 
described in “Using Phone Lookup” in the pdQ Basics 
Handbook.

About To Do List Shows version (revision) information for the To Do 
List application. 
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Appendix A

Expense Templates

This appendix provides illustrations of the four expense templates that 
come with the Palm™ Desktop software. You may use or modify any of these 
templates when creating expense reports with data from the Expense 
application.

Sample 1
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Appendix B

Creating a Custom Expense Report

This section explains how to modify existing Expense application templates, 
and how to create your own custom expense report templates for use with 
the Expense application.

This section assumes that you are familiar with Microsoft Excel or 
a similar spreadsheet application. If you are not familiar with 
Microsoft Excel, consult your company’s Information Services 
department or another experienced user.

About Mapping Tables
Before creating or modifying an Expense template, it’s important to 
understand the function of Palm™ Desktop’s Expense application. In simple 
terms, the Expense application is designed to move Expense data from your 
pdQ smartphone into a Microsoft Excel spreadsheet.

Each Expense item stored in pdQ smartphone represents a group of related 
data. The following data can be associated with an expense item:

■ Category ■ Payment Currency

■ Date ■ Vendor

■ Expense Type ■ City

■ Amount ■ Attendees

■ Payment Method ■ Note

When you perform a HotSync® operation between pdQ smartphone and the 
Palm Desktop on your computer, the Expense data is stored on your 
computer (in a file named Expense.txt). When you open the Expense 
application in Palm Desktop, an Excel macro starts, and populates an 
expense template with your data based on the rules specified in a 
spreadsheet file named Maptable.xls. 

The Maptable.xls file is an editable spreadsheet that functions as a 
“mapping table.” The function of the mapping table is to guide the Excel 
macro in extracting the Expense data. The mapping table tells the Excel 
macro how large the spreadsheet is and provides the data-cell layout of the 
Excel template used for the Expense Report.
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Customizing Existing Sample Templates
Four sample Expense Report templates come with Palm Desktop. These 
templates are stored in the Templates folder (which is in the same folder as 
the Palm Desktop application). 

If the layout of one (or more) of these templates is appropriate for your 
reporting needs, you can easily customize the templates with your company 
name and other information.

To customize a sample Expense Report template:

1 Make a backup copy of the contents of the Templates folder.

2 Double-click the name of the sample template you want to modify to 
open it in Microsoft Excel.

3 Make any changes that you want to the names (or other information) 
in the sample template.

Do not insert rows or columns in the sample template. Doing so 
changes the way your Expense data maps to the template and 
causes errors. If you want to move the cells to a different location 
or add or delete rows or columns, you will have to make changes to 
the Maptable.xls file.

You can insert your own company logo without changing the 
Maptable.xls file. However, if you change the file name, you need 
to make a corresponding change in the Maptable.xls file.

You can also rename cells without changing the Maptable.xls file 
— provided that the expense type corresponds to pdQ smartphone 
data. For example, you can change “Snack” to “Munchies” — and 
then all items entered on pdQ smartphone as “Snack” will map to 
the cell(s) labeled “Munchies.”

4 Choose Save As from the File menu to open the Save As dialog.

5 Click Save as type drop-down list and choose Template (*.xlt).
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6 Navigate to the Templates folder (in the Palm Desktop directory).

If you do not need to change the Maptable.xls file, save the 
template file with its original file name (e.g., Sample2.xlt).

If you do need to change the Maptable.xls file, give your modified 
template a unique name. Be sure to use the .xlt file suffix, which defines 
the file as a Microsoft Excel template.

7 Click Save to save your modified template and make it available for 
future use.

If you need to modify the Maptable.xls file, you must do this before 
you can use the modified template with your Expense data. To 
modify the Maptable.xls file for your new template, see 
“Programming the Mapping Table” later in this appendix. Read all 
of the sections of this appendix before making changes to the 
Maptable.xls file.

Determining the Layout of the Expense Report
This section describes the layout considerations for the Expense Report and 
explains the terms used for creating the report. 

Labels
There are two kinds of labels that you need to define for your report: day/
date and expense type. Each kind of label can be either Fixed or Variable. A 
Fixed label means that the label always appears as a header at the beginning 
of a row or column. If a label is not Fixed, it is variable.

For example, a list table of expenses could have variable labels in the rows 
for day/date, and variable labels in the columns for expense type. In this 
case, neither day/date–or expense type information would be “fixed” (as a 
header). Instead, the date and expense type information would be filled 
into the cells of the spreadsheet as appropriate.

Examples of both Fixed and Variable labels appear in the sample expense 
templates. 
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Sections
A Section is an area of the report that has common formatting. It is common 
for an Expense report to have more than one Section. For example, the 
following sample Expense Report named Sample3.xlt contains several 
Sections.

Because your Expense data maps to row and column areas of your final 
report, different Sections require different definitions for the data mapping. 
To create additional Sections with different mapping, you create 
corresponding additional lines to the mapping table file named 
Maptable.xls. This procedure is explained later in this appendix.

If a section contains cells for prepaid (company paid) expenses, you need 
to create an additional line in the mapping table for “prepaid.” This will 
count as an additional section in the mapping table. The only data that 
differs in the prepaid section (from the non-prepaid section) is the row/
column numbers for the expense type.

Analyzing Your Custom Expense Report
If you already have a custom Excel expense report, you can use it with a 
modified mapping table. However, before you can create a Maptable.xls file 
that corresponds to your custom Expense Report, you must first analyze the 
characteristics of your report. 

Section 1 
(not prepaid)

Section 2 
(prepaid)

Section 3 
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Perform the following before you begin a custom mapping table:

■ Print a copy of your custom expense report. Activate the Row and 
Column Headings option in the Sheet settings of the Page Setup 
command. This enables you to quickly determine the size of the 
Section(s), as well as the numbers for the start rows and columns.

■ On the printed copy, identify the data Sections. A Section is an area of 
data with common row and column formatting. A yellow highlighter 
marking pen can make it easy to see the Sections as you work with 
programming the mapping table. Your custom Expense Report can 
contain any number of Sections, and the same data can be repeated in 
any Section.

■ On the printed copy, identify the type of Labels that apply to each 
Section. Each Section can have only one kind of Fixed or Variable Label 
for rows. Likewise, each Section can have only one kind of Fixed or 
Variable Label for columns.

■ Place a copy of your custom Expense Report in the Templates folder (in 
the Palm Desktop directory). Change the file name so it has the file 
extension .xlt (which defines it as a Microsoft Excel Template). Make a 
note of the exact file name so it can be defined in the mapping table 
file.

Programming the Mapping Table
Once you have analyzed the components of your custom Expense Report, you 
can program the mapping table to fill the report with data from pdQ 
smartphone.

To program a new custom mapping table:

1 Open a copy of the Maptable.xls file in Microsoft Excel. 

This file is located in the same folder as the Palm Desktop 
application. Make a backup copy of this file before you make your 
modifications.

2 Mapping a new template. Scroll to where you find the name of the 
original template that you chose for your modifications. The name of 
the template will appear in column B of the Maptable.xls file, next to 
the cell highlighted in green that reads “Template Name:”. If you did 
not modify an existing template, move to any table in the Maptable.xls 
file. 

3 Select all the rows associated with the template name. To select the 
rows, click and drag on the row numbers (left side), so they appear 
highlighted.
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4 Choose Copy from the Edit menu.

5 Scroll down to a blank area of the Maptable.xls file (below the rows used 
for Sample4.xlt), and click on a row number to select a blank row.

6 Choose Paste from the Edit menu. A copy of the rows you selected in 
step 3 is pasted into the Maptable.xls file.

7 Name the table. In the cell immediately to the right of the cell entitled 
Template Name, enter the exact file name of your custom Expense 
Report template. 

8 Define the number of Sections. Each row in a table defines how pdQ 
smartphone data will be placed in a Section of your custom Expense 
Report. Note that the prepaid portion of a section has its own row and 
counts as a separate section for map table purposes, even though it is 
not a separate section in your template.

All rows 
associated 
with 
template 
are 
selected 

Table with 
four sections
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You may add or delete rows as necessary so that the total number of rows 
corresponds to the number of Sections in your custom Expense Report. 
To clear all of the existing settings in a row, click to select the row and 
press Ctrl+Delete. Name each row to correspond to a Section of your 
custom Expense Report.

9 Determine the Label settings. The orientation of the data fields (Row, 
Column) appears in the yellow section of the table.

Determine whether the Rows will contain expense or date information, 
and place an “x” in the appropriate cell. When you do this, you also 
define whether the label is Fixed or Variable. You can place only one “x” 
in the Row section (columns 2–5).

Determine whether the Columns will contain expense or date 
information, and place an “x” in the appropriate cell. When you do this, 
you also define whether the label is Fixed or Variable. You can place only 
one “x” in the Column section (columns 6–9).

10 Define the dimensions of the Section. The dimensions of the Section 
appear in the green columns (10–13).

# of Rows Represents the total number of rows in the Section, 
excluding any header or total rows. In other words, this 
includes only the number of rows in the Section where 
pdQ smartphone data will be placed.

# of 
Columns

Represents the total number of columns in the Section, 
excluding any header or total columns. In other words, 
this includes only the number of columns in the Section 
where pdQ smartphone data will be placed.

Start Row Is the number of the first row of the Section that will be 
filled with pdQ smartphone data.

Start 
Column

Is the number of the first column of the Section that will 
be filled with pdQ smartphone data.
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11 Define the Dates and Intervals. The dates and intervals between dates 
appears in the light blue columns (14–17).

In the Date cell, enter the row or column number where all the date 
information will be placed.

In the Dates cell, enter the number of blank columns (or rows) 
separating the date fields. If there are no blank columns (or rows) 
between date entries, leave this number set to zero.

In the Start Day cell, enter the day of the week that starts the expense 
reporting period. Enter a three-character abbreviation for the day (e.g., 
Sun, Mon, Tue).

In the Day cell, enter the row or column number where all the day 
information will be placed. If the dates are in a row, enter the row 
number. If the dates are in a column, enter the column number.

12 Define whether the Section is in list format. This setting appears in 
the light purple columns (18–19).

If the Section will present the data in a list format, enter the word “yes”. 
Otherwise, enter the word “no”. The following diagram shows data 
presented in a list format:

Only if your section is in list format: In the Expense Type cell, enter 
the number of the row or column where the expense description will be 
placed. Expense amounts can be entered in several different columns or 
rows if required by your template. Expense type labels must all appear in 
the same column.

13 Enter the row or column numbers for the expense types that appear 
in the Section. These settings appear in the aqua columns (20–48).

pdQ Apps.book  Page 158  Monday, October 26, 1998  10:50 AM



Appendix B Creating a Custom Expense Report 159
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Programming the Mapping Table
Experiencing the pdQ™

 
Advantage

Creating a Custom
 

Expense Report
W

orking w
ith Organizer 

Features
W

orking w
ith Phone and 

M
essaging Features 

For these settings, simply enter the row or column number for the 
expense types that you want to appear in the Section. Note that the 
same row or column number can be used more than once. An example of 
this would be meals that encompass breakfast, lunch, dinner and snacks. 
In the previous example, all expense items would be populated into row/
column 4 of the custom Expense Report.

14 Complete the table. All of the remaining columns (49–57) in the table 
are used to define the column or row number that corresponds to the 
description. 

15 Mark a Section for prepaid expenses (yellow column). If a row in the 
map table is for prepaid (company paid) expenses, type a “yes” in the 
cell on that Section’s row. Type “no” in all the cells of this column that 
do not pertain to prepaid expenses.

16 Repeat steps 9 through 15 for each Section that you have defined for 
your custom Expense Report. 

17 Map Expense Report Options dialog (magenta section). The Expense 
Report Options dialog has five fields where you can fill in data for the 
header on your expense report. Use this section to specify the row and 
column on your template where this information will be mapped. 

Because header data is not related to any particular Section, you have 
to fill in only one row. If the item does not appear on your template, 
leave these cells blank.

pdQ Apps.book  Page 159  Monday, October 26, 1998  10:50 AM



160 pdQ Applications Handbook
QUALCOMM Proprietary 80-68789-1 Rev X2, PRELIMINARY - 10/26/98

Using Applications Other Than Microsoft Excel

Using Applications Other Than Microsoft Excel
You can use applications other than Microsoft Excel (such as Lotus 1-2-3 or 
Quattro Pro) to open and manipulate the Expense data on your computer. 
The data file is named “Expense.txt,” and is stored in the Expense folder, 
within the folder containing pdQ smartphone user data.

Expense data in the Expense.txt file is in tab-delimited format.

Expense File Details
The Expense.txt file contains four groups of data. It will be easier to see 
these four distinct groups of data if you open the file with a spreadsheet 
application.

Trips Shows the number of Expense application categories, 
and lists each one followed by an “end” statement.

Currency Shows how many currencies were used for the Expense 
data, and lists the countries that correspond to that 
currency.

Trip Shows the number of expenses by category, and lists the 
expenses for each category.

Expenses Shows the total number of expenses, and lists them 
chronologically.
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Appendix C

Non-ASCII Characters for Login Scripts

The following information enables you to create custom login scripts that 
require non-ASCII characters. It is provided for advanced users who 
understand the use and requirements of such characters in a custom login 
script.

Use of ^char
You may use the caret ( ^ ) to transmit ASCII command characters. If you 
send ^char, and the ASCII value of char is between @ and _, then the 
character is automatically translated to a single-byte value between 0 and 
31. For example, ^M is converted to a carriage return. If char is a value 
between a and z, then the character sequence is translated to a single-byte 
value between 1 and 26. If char is any other value, then the character 
sequence is not subject to any special processing.

For example, the string “Joe^M” transmits Joe, followed by a carriage 
return.

Carriage Return and Line Feed
You may include carriage return and line feed commands as part of the login 
script, when entered in the following format:

<cr>Sends or receives a carriage return

<lf>Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed 
by a carriage return and line feed from the remote computer before 
executing the next command in the script.
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Literal Characters

Literal Characters
The backslash ( \ ) character defines that the next character is transmitted 
as a literal character, and is not subject to any special processing ordinarily 
associated with that character. 

Examples:

\^ Includes a caret as part of the string

\< Includes a < as part of the string

\\ Includes a backslash as part of the string

pdQ Apps.book  Page 162  Monday, October 26, 1998  10:50 AM



 Index i
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Index

A
Adding

Address Book entries   2
Date Book entries   22
To Do items   140

Adding, Editing, or Deleting a Bookmark 
  117
Address

mail message   70
Address Book   1

beaming   9
business card   9
categories   7
creating entry   2
deleting entries   4
editing entry   4
entry details   8
features   1
list by company   7
lookup entries   5
menu commands   10
phone numbers   6

Advanced EudoraMail Features   110
Alarm

setting   26
Alarm Sounds   124
Applications

Address Book   1
Date Book   21
Expense   39
Memo Pad   91
security   131
To Do List   137,   139

Attendees   43
Automatic fill   51
Auto-Off Delay   124
B
Backlight

pen stroke   121
Batteries

auto-off delay   124
Beaming

Address Book categories   10
Address Book entries   10
business card   9
Date Book entries   34
pen stroke   122

To Do List   146
Blind Carbon Copy   72

defining   73
blind carbon copy (Bcc) e-mail message 
  104
Business Card

beaming   9
selecting   9

Button Preferences   120
pen   120

C
Calculator

buttons   15
clear entry   15
memory   16
menu commands   16
recent calculations   16

Categories
Address Book entries   7
beaming   10,   146
Expense   42
memos   93
To Do List   142

Changing
Address Book entries   4

Closing E-mail Messages   110
Conduits   59
Confirm Delivery   72
Confirm Read   72
Connecting

service templates   125
Connecting to the Internet   118
Copying Text from an Internet Site to pdQ 
Applications   116
Create Bookmark   114
Creating

Address Book entries   2
Date Book entries   22
Mail messages   68,   101
memos   91
to do items   140

Creating an Address Book Entry   2
D
Date

Expense item   41
in message list   80
scheduling event   24

pdQ Apps.book  Page i  Monday, October 26, 1998  10:50 AM



ii pdQ Applications Handbook
QUALCOMM Proprietary PRELIMINARY - 10/26/98, 80-68789-1 Rev X2

Index

to do item   142
Date Book

alarm   26
beaming entries   34
deleting events   29
event conflicts   31
event date   24
event duration   22
event start time   22
features   21
menu commands   33
month view   32
private events   29
repeat event   27
rescheduling events   26
scheduling event   22
selecting date   24
switching views   29
untimed event   22,   24
week view   30

delete a bookmark   116
Deleted

messages in folder   78
purging messages   79

Deleting
Address Book entries   4
Date Book events   29
memos   94
messages   78
password   134
service templates   125
To Do items   143

Details
Address Book   8
Expense   41
To Do items   142

Digitizer   122
Disconnecting From the Internet   117
Draft Messages   76
E
edit a bookmark   116
Editing

Address Book entries   4
Editing an Unsent E-mail Message   105
Editing Unsent Messages   75
Entering

Date Book entries   22
Mail messages   68,   101
memos   91
to do items   140

Entries

Address Book   2
beaming   10
Date Book   22
hiding private   131,   132
memos   91
showing private   132
To Do List   140

EudoraMail   99
EudoraWeb   97,   113
Event

changing to untimed   25
conflicts   31
date   24
Date Book scheduling   22
deleting   29
in week view   31
private   29
repeat   27
setting alarm   26
start and duration   22
untimed   22,   24

Expense
attendees   43
categories   42
currency list   44
custom currency   51
custom report   151
default currency   51
details   41
features   39
item currency   43
item date   41
menu commands   49
opening   39
receipt details   41
show options   44
spreadsheet   47
templates   48,   147
type   42
vendor   43
viewing data   45

F
File

messages   77
File Link   62
Filter

defining custom   84
high priority   85
ignoring messages   82

Finding
Address Book entries   5

pdQ Apps.book  Page ii  Monday, October 26, 1998  10:50 AM



 Index iii
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Index

Folders   79
Fonts

Mail message   67
Format Preferences   123

country default   123
time format   123

Forward command   105
G
General Preferences

alarm sounds   124
auto-off delay   124
system sounds   124

Graffiti
editing shortcut   129

Graffiti Help
pen stroke   121

H
Header Information   67,   101
High Priority

message filter   85
HotSync

conduits   59
customizing   59
features   53
File Link   62
filtering options   82
first time   54
HotSync Manager   53
local   55
local settings   57
modem settings   58
options   55,   81
user profile   60

HTML   110
I
Inbox   79
K
Keyboard

pen stroke   121
L
Look Up

Address Book entries   5
Looking Up an Address   70,   103
M
Mail

address lookup   70
blind copy   73
changing setup   65
confirmations   75
creating   68,   101

custom filter settings   84
deleting messages   78
desktop configuration   64
draft messages   76
edit unsent messages   75
features   63
filing messages   77
filtering options   82
filters   82
folders   79
HotSync options   64,   81
menu commands   87
message list options   79
messages   66,   100
opening   114
priority   73
priority filter   85
purge messages   79
recovering deleted   78
sending messages   75
show date   80
signature   74
sorting   80
synchronizing   66
truncating   86

making a call with the flip closed   37, 
  138
Managing EudoraMail Attachments   110
Memo

arranging in list   93
categories   93
creating new   91
deleting   94
private   94

Memo Pad
arranging memos   93
creating memo   91
features   91
menu commands   95

Memory
calculator   16
purge date book   50
purge to do list   145

Menu Commands
for network   125
Mail   87

Menus
Address Book   10
Date Book   33
Expense   49
Memo Pad   95

pdQ Apps.book  Page iii  Monday, October 26, 1998  10:50 AM



iv pdQ Applications Handbook
QUALCOMM Proprietary PRELIMINARY - 10/26/98, 80-68789-1 Rev X2

Index

To Do List   144
Messages   66,   100

address lookup   70
bcc   72
confirm delivery   72
confirm read   72
confirmations   75
creating   68,   101
deleting   78,   106
draft   76
editing unsent   75
filing   77
font style   67
header information   67,   101
in deleted folder   78
list options   79
priority   72,   73
purging deleted   79
sending   75
show date   80
signature   72,   74
sorting   80
truncating   86

Month
Date Book view   32

N
Network

menu commands   125
New

Address Book entry   2
Expense item   40
Graffiti shortcut   128
memo   91
messages   68,   101
to do item   140

New Message screen   101
O
Outbox   79
Owner Preferences   127
P
Palm Desktop

configuring mail   64
customizing HotSync   59
File Link   62
HotSync options   55

Palm III
assigning password   131
changing password   134
common data   60
deleting password   134
forgotten password   135

locking with password   133
sound settings   124

Password
assigning   131
changing   134
deleting   134
forgotten password   135
locking Palm III   133
with owner preferences   127

Payment
Expense item   42

Pen
preferences   120

Phone Numbers
choosing type   6

Power Off
pen stroke   122

Preferences
button   120
Digitizer   122
features   119
Format   123
general   124
owner   127
ShortCut   128

Printing
expense reports   46

Priority   72
setting   73
to do item   140

Private
assigning password   131
events   29
memos   94

Private entries
hiding records   132
showing   132

Profiles   60
Purge

date book events   50
deleted messages   79
to do items   145

R
Records

Address Book   2
beaming   10
Date Book   22
hiding private   131,   132
showing private   132
To Do List   140

Recovering

pdQ Apps.book  Page iv  Monday, October 26, 1998  10:50 AM



 Index v
80-68789-1 Rev X2, PRELIMINARY - 10/26/98 QUALCOMM Proprietary

Index

deleted mail   78
filed mail   78

Removing
Address Book entries   4
Date Book events   29
memos   94

Replying to E-mail Messages   105
S
Security

assigning password   131
changing password   134
deleting password   134
features   131
forgotten password   135
hiding records   132
locking Palm III   133
opening   131
showing records   132

Selecting
date   24

Sending Messages   75
Service Templates   125

deleting   125
ShortCut

preferences   128
ShortCuts

deleting   129
editing   129

Show Date   80
Show Options

To Do List   143
Signature   72

adding   74
Size

message font   67
Sorting

Address Book   7
memos   93
message list   80

System Sounds   124
T
Templates

expense report   48
for expense report   147

Time
alarm setting   26
format   123
setting event   22

To Do List
categories   142
checking off item   141

completion date   144
creating item   140
deleting items   143
features   137,   139
item details   142
item due date   142
item priority   140
menu commands   144
show due items   144
show options   143

Truncate   86
U
Untimed Events   22,   24
User Profile   60
V
Vendor   43
W
Week

Date Book view   30

pdQ Apps.book  Page v  Monday, October 26, 1998  10:50 AM



vi pdQ Applications Handbook
QUALCOMM Proprietary PRELIMINARY - 10/26/98, 80-68789-1 Rev X2

Index

pdQ Apps.book  Page vi  Monday, October 26, 1998  10:50 AM


